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Justcroft International

Introduction
JustIMAGE  5.4 is  a  product  suite  for  viewing,  converting  and  plotting  image  files.
JustIMAGE 5.4 is available for Windows™ and Linux.

This manual will show you, as a user, how to work with JustIMAGE 5.4 in various situations.
Application administrators and advanced users should read the “JustIMAGE 5.4 Reference
Manual”.

JustIMAGE 5.4 comes with several files you can use to test the functionality of JustIMAGE
5.4. These test files are located under the testfiles sub-directory of the installation. These
test files are used in the examples of this manual.
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General Information

What Is JustIMAGE 5.4?
JustIMAGE 5.4 is a product suite for viewing, converting and plotting large, complex image
files. JustIMAGE 5.4 is available for Windows™ and Linux.

We are proud of our CGM interpreter support. Unlike other CGM interpreters, we strive for
100% support of the CGM standard including CGM version 4. We support the special CGM+,
CGM*PIP extensions, which are required by the Oil & Gas Industry. We have also extended
our CGM interpretation with ATA and WebCGM support. There are no additional license
costs for CGM+, CGM*PIP, ATA or WebCGM support.

Our  CGM  interpreter  core  has  some  special  features  that  reduce  common  CGM
interpretation problems:

• Automatic package profile detection for automatic CGM interpretation correction.

• Automatic CGM cell array splitting.

• CGM Element limits based on CGM*PIP/II, ATA and WebCGM.

The Modules
The JustIMAGE 5.4 program suite consists of a number of modules. Some of these modules
are also available as command line programs.

The JustIMAGE 5.4 User Interface is the main program that gives you access to the different
JustIMAGE 5.4 modules.  The graphical  user  interface  allows you to  control  the  various
modules in a consistent way, so that any module is seamlessly integrated.

You need a license for the JustIMAGE 5.4 product suite. Each module of the JustIMAGE 5.4
program suite  is  license  restricted with one or  more  license features.  This  is  a  technical
method of enforcing the license restriction. Contact Justcroft International for an overview of
what is licensed.

Viewer Module
The Viewer module allows you to preview files. You can rotate, zoom and pan on the picture
you are previewing. This module also allows you to analyze CGM files and create statistical
reports with our CGM Analyser. Advanced users can also run the CGM Analyser on the
command line.
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Input File Converter Module
This module allows you to load non-CGM graphics formats into the JustIMAGE 5.4 Viewer.
JustEDIT, JustMONTAGE and The Batch Processor also use the Input File Converter module.

Conversion is either vector graphics to CGM vector graphics or bitmap graphics to CGM cell
arrays. The following formats are supported.

Format Remarks

BMP Windows® device independent bitmap. Supported are 1, 4, 8 and 24 
bits. OS/2 bitmaps are not supported. The generated CGM is always 
abstract.

CalComp 906/907 Limited HCBS support. Conversion is to CGM version 3 vector 
graphics. The generated CGM is always metric.

CalComp 925 Conversion is to CGM vector graphics. The generated CGM is always 
metric.

CALS CALS type 1 and type 2. The generated CGM is always metric. By 
default the image will be automatically rotated to landscape during 
conversion if the height is larger than the width.

DGN V7 MicroStation V7 Design files. Requires an additional license. See 
“MicroStation Design File Converter Module“ below for details.

ECW Enhanced Compressed Wavelet files. Requires an additional license. 
See “Enhanced Compressed Wavelet Converter Module“ below for 
details.

EMF Conversion is to CGM version 3 vector graphics. The generated CGM 
is always metric.

GIF Each GIF picture is converted to a CGM picture. The generated CGM is
always metric.

HP-GL Only the first HP-GL picture is converted. Conversion is to CGM vector
graphics. The generated CGM is always metric.

HP-GL/2 HP-RTL is not supported. Only the first HP-GL picture is converted. 
Conversion is to CGM vector graphics. The generated CGM is always 
metric.

Insight Raster Only Black & White raster files are supported. The generated CGM is 
always metric.

JPEG The generated CGM is always metric.

PDF PDF version 1.3 and higher with restrictions. Conversion is, by default, 
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to CGM vector graphics. 
There is also an optional PDF to CGM bitmap converter.  The 
generated CGM is always metric.

PDS Schlumberger Picture Description Standard files. See “Schlumberger 
PDS Files“ below for details.

PNG The generated CGM is always metric.

PostScript PostScript language level 1, 2 and 3. Conversion is usually a bitmap 
CGM. The generated CGM is always metric.

Raw Print Raw Print format file with a fixed scan size and resolution.  Conversion
to a CGM bitmap. The generated CGM is always metric.

TIFF Baseline TIFF is supported. JPEG compression, Deflate compression 
and the FAX G3/G4 extensions are supported. The generated CGM is 
always metric. By default the image will be automatically rotated to 
landscape during conversion if the width:height ratio is larger or equal 
to 1:2.

WebP Web Portable format. The generated CGM is always metric.

WMF Conversion is to CGM version 3 vector graphics. The generated CGM 
is always metric.

XWD The generated CGM is always abstract.

The Input File Converter module is part of the  JustIMAGE 5.4 installation but is licensed
separately.

Output File Converter Module
The  Output  File  Converter  module  allows  you  to  export  the  picture  you  are  currently
previewing. You can export to several popular bitmap formats such as TIFF, GIF and PNG at
any size or resolution. You can also save to Adobe Portable Document Format (PDF) and
Scalable Vector Graphics format (SVG). Both PDF export and SVG export is vector output,
including true text support.

Use  the  Batch  Processor if  you  want  to  convert  multiple  files  to  a  specific  file  format.
Advanced users can run the Output File Converter as a command line program if needed.

The Output File Converter module is part of the JustIMAGE 5.4 installation but is licensed
separately.
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Print Management Module
The Print Management module allows you to print files to any supported printer. There are
several printing options available. The Batch Processor also uses these printing options.

OS System Driver
The OS System Driver option is mainly intended for text printing on small paper sizes and is
not intended for complex graphics printing. It relies on the native printing architecture of the
OS.

Justcroft Printer Driver
Justcroft International has many years of experience with printing complex CGM graphics on
UNIX® and Windows® systems. Our own printer drivers will give you the benefit of high-
performance, high-quality output.

By using a virtual raster device, we can guarantee no differences in output between different
printers.

Justcroft printer drivers are less resource intensive. You can get amazingly large plots with
the least amount of printer memory and disk space. Our drivers can handle up to 500 meters
length output.

There are two types of Justcroft printer drivers:

• Raster driver output in general suitable for printers and plotters that allow raw raster
data.  The  device  can  print  at  maximum  speed,  because  no  special  interpretation
needs  to  be  done  except,  possibly,  raster  data  decompression.  The  raster  data  is
generated off-line which ensures that the printer and plotter are only occupied during
the physical printing process. JustIMAGE 5.4 will use the CPU power and memory of
your Operating System. There is no need to buy extra memory for your printer or
plotter.  Supported  raster  types  include:  PCL,  HP-RTL,  Epson  ESC/P,  iSys  RTL,
Printrex raster, Neuralog, Versatec, OYO, Graphtec, Canon GARO and TIFF mono
raster.

• PostScript vector driver output. PostScript is a graphics vector description language,
which is very popular for Desktop Publishing (DTP). Because it also a programming
language you can create complex graphics with relatively small file sizes.

The Print Management module requires a license.
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JustPLOT Submit
JustPLOT is Justcroft's system for printing and plotting in a mixed network environment.
The JustPLOT submit option is part of the JustIMAGE 5.4 installation. You do need to have
one or more JustPLOT Servers installed in order to be able to submit print jobs.

JustIMAGE Driver
Until  now,  when  our  customers  wanted to  print  or  export  an  image  from one  of  their
Windows Geological and Geophysical applications (G&G) they first had to export the image
to an output file, start up JustIMAGE 5.4 and then load the image file into JustIMAGE 5.4.

To remove these extra steps and improve the work-flow we have developed the "JustIMAGE
Driver".  Now a user can use the File -> Print window within the G&G Windows application
to put the image directly into a JustIMAGE 5.4 Viewer, Print or Export window.

The JustIMAGE Driver module is part of the JustIMAGE 5.4 download but must be explicitly
enabled during the installation. The module itself does not require a separate license but the
various selectable modules (Viewer, Print, Export) do require a license.

CGM Optimiser Module
The CGM Optimiser is an application that allows you to convert CGM, CGM+ and CGM*PIP
files so that these can be loaded into graphics applications.

Because CGM is an all-purpose graphics standard, there are many aspects of the file format
that are not specifically defined in the standard.

Another problem is the general complexity of the CGM format. Not only are there three
different ways to encode the file, but also the large number of CGM graphics elements and
the complexity of these elements make it difficult to support every possible feature of the
CGM format.

Most programs support only a specific subset of the CGM standard, mostly because –unlike
the CGM Optimiser– it is not the native file format of the program.

The third category of problems is caused by industry specific extensions such as CGM+ and
CGM*PIP.  General  drawing  packages  such  as  CorelDRAW™ or  MicroStation™ do  not
support these extensions.

The CGM Optimiser solves CGM problems by analyzing the CGM file and converting the
original CGM into a format that is better suited for import into a drawing packages. It takes
the CGM file you want to convert and changes it into one or more other files that can be
imported in the drawing package. 
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The converter performs several default analyzes and conversions:

• Correction of certain CGM file constructions that are known to cause problems. For
example, CGM Metafile defaults are moved to the CGM Begin Picture State.

• Direct color output is generated if color index values higher than 255 were used in the
original CGM file. Most drawing packages can handle only 256 index colors.

• A clear text CGM file is converted to a binary CGM. Most drawing packages only
support the binary CGM encoding.

• If the input file is a CGM+ or CGM*PIP file and seismic sections are detected a seismic
rendering  is  performed.  The  non-seismic  CGM  elements  (the  standard  CGM
elements) are kept in a CGM output file. Rectangle(s) are drawn in the output CGM
file to help in placing the associated rendered seismic sections when the user wishes
to re-combine the output files.

• The rendered seismic sections are placed in a separate bitmap file. This file can then
be imported in the drawing package and combined with the converted CGM file.

• Large Cell arrays are split into smaller cell arrays.

• Common CGM graphics elements that are outside the active clip are removed from
the  CGM  output,  both  reducing  the  file  size  and  making  import  into  drawing
packages simpler.

• Line joining and Fill joining reduces the number of CGM elements making import
into drawing packages simpler.

The CGM Optimiser can be run for multiple files using the Batch Processor or can be started
from the command line.

The  CGM  Optimiser  module  is  part  of  the  JustIMAGE  5.4 installation  but  is  licensed
separately.

JustMONTAGE Module
The  JustMONTAGE module is a program that allows you to create compositions of CGM
images in combination with graphical shapes on a canvas. The composition can be created as
a single CGM suitable for plotting, rendering to a bitmap format or importing into other
graphics packages. JustMONTAGE will preserve the CGM seismic extensions in the resulting
composition CGM. JustMONTAGE can also translate raster or vector data into CGM so that
it can be used in the composition.

JustMONTAGE stores a composition in a simple XML format whose structure is based on the
Scalable Vector Graphics (SVG) standard of the World Wide Web Consortium (W3C).
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The  JustMONTAGE module  is  part  of  the  JustIMAGE  5.4 installation  but  is  licensed
separately.

JustEDIT Module
The  JustEDIT module is a program that allows you to edit graphics files, primarily CGM
files. Many of the features within JustEDIT have been developed following requests from our
customers who were not totally happy with their current graphics Editor. As a result, as well
as the normal editing functionality, the following special functionality has been included:

• Smooth. Smooth a line by adding more vertices.

• Find and Replace. Replace all objects fitting specific attributes such as edge color, line
width, etc.

• Close Gaps. Close the gaps between disjoint lines.

• Cut Line. Discard a part of a (poly) line.

• Split Line. Cut a (poly) line into two separate lines.

• Insert  Fill:  Create  transparent  fills  between lines  or  turn a  single  poly line  into  a
(filled) polygon.

• To Unconformity. Convert a line into a sinusoidal wave.

• Fill with Symbols and Fill with Images. Fill a polygon with symbols or a small image.

The JustEDIT module is part of the JustIMAGE 5.4 installation but is licensed separately.

JustSEARCH Module
When was the last time you were looking for an image file? You know roughly when it was
created,  by  whom  and  some  idea  of  its  title  — but  where  to  start  looking  among  the
workstations and servers out there?

Well, help is at hand. We have created a JustSEARCH module that can help you find that file
quickly  and  easily.  It  allows users  to  retrieve  a  file  by  specifying  any  known attributes
without needing to know its location. These attributes could include: file name (or part of the
file name), file type, date created, date modified, creator, etc.

JustSEARCH works by initially creating an Index of all image files held in a given set of
locations. These locations could be file-systems, disk arrays, cloud location, etc.  For each
image file it finds, it stores the precise location of the file, its attributes and a thumbnail of the
image.

JustSEARCH is a client / server system. The client API is integrated in the Viewer module,
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JustEDIT module  and  JustMONTAGE module  but  is  licensed  separately.  A  manager
interface for JustSEARCH is part of the  JustIMAGE 5.4 installation. The server is part of a
separate installation.

MicroStation Design File Converter Module
You can convert  MicroStation DGN V7 files to a CGM using our MicroStation Design File
Converter.  This  converter  includes  support  for  the  Zeh specific  plotting extensions  (Zeh
Level Definition).

The MicroStation Design converter is part of the  JustIMAGE 5.4 installation but is licensed
separately.

Export to PowerPoint
The Export to PowerPoint module allows you to quickly and easily create PowerPoint 2007
slides from an image.

The  Export  to  PowerPoint  module  is  part  of  the  standard  JustIMAGE  5.4 Windows
installation but is licensed separately from JustIMAGE 5.4. It is not available for platforms
other than Windows.

Enhanced Compressed Wavelet Converter Module
The Enhanced Compressed Wavelet converter allows you to download  ECW images and
convert these to a CGM file.

The Enhanced Compressed Wavelet converter is part of the JustIMAGE 5.4 installation but is
licensed separately from JustIMAGE 5.4 and falls under the US export restrictions.

Schlumberger PDS Files
Schlumberger PDS files can be imported through the Schlumberger  PDS2CGM converter.
The PDS2CGM converter is part of the Schlumberger GeoFrame suite. On Windows you will
need PDSView  .

Screen Capture
You can make screen captures with JustIMAGE 5.4 and this is available at no extra cost.

Movie
The Movie tool allows you to make time-lap screen captures and turn them into an AVI
movie.
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Movie is part of the JustIMAGE 5.4 installation and is available at no extra cost.

Batch Processor
The Batch Processor allows you to convert multiple files in one run. In addition there is also a
hot directory mode. The Batch Processor  runs independently from the JustIMAGE 5.4 User
Interface so that you can continue working while the Batch Processor is running.

The following processing types are possible:

• Convert to CGM. Convert one or more files to a CGM.

• Convert to non-CGM. Convert one or more files to a bitmap, PDF or SVG.

• Optimise files. Perform line joining and fill joining on the specified files.

• Process  for  graphics  applications.  Run the CGM Optimiser  to import files into a PC
drawing package. Split CGM+, CGM*PIP into a normal vector CGM and a raster file
for the seismic.

• Merge PDFs. Merge two or more PDF files into a single multi-page PDF.

• Print files. Print multiple files.

The Batch Processor is part of the JustIMAGE 5.4 installation.

Contact Information
Customer Support Center

Telephone: +31 70 364 4131

Email: support@justcroft.com

Support web site: support.justcroft.com
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Previewing

Opening a File
You can open a file by selecting the “Open” command from the File menu. The File Open
dialog box is shown1:

Type the name or select the file you want to open. The Files list box shows all the files with
the extension as specified under the Files of type field. JustIMAGE 5.4 will load the file once
you click on Open and the file format is supported.

You can also open a file by dragging a file from the File Explorer to the preview area. The last
eight opened files can be selected from the File menu.

The  File  Next  File and  File  Previous  File commands  allows  you  to
quickly browse through a directory of files. Note: The directory and file type are based on

the selection in the File Open dialog box.

1 The actual dialog box shown depends on the OS platform you are using and your current lan-
guage.
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If you don't know the exact name or location of a file, you could use the File  Retrieve
assuming  JustSEARCH has been setup. See the “How to Retrieve a file” chapter for more
information.

Use the File Close command if you want to close the current open file. This is useful if
the file needs to be overwritten by another program such as JustEDIT.

How to Import Different File Types
You can import BMP, CalComp 906, CalComp 907, CalComp 925, CALS, MicroStation DGN
V72,  EMF,  GIF,  HP-GL,  HP-GL/2,  Insight Raster,  JPEG,  PDF,  PDS3,  PNG,  PostScript,  TIFF,
WebP, WMF and XWD files. These are converted into (temporary) CGM files. You can open
these types of files through the File Open dialog box or by drag and drop to the preview
area.

Multi page  TIFF,  PostScript and  PDF files can be saved as a multi–picture CGM file. Each
picture will be saved as a separate TIFF/PostScript/PDF page.

Stitching
You can merge or join pages of PDF files, PostScript files or TIFF files together into a single
CGM image. Use the File  Close first if you have already a file in the previewer. You can
skip this if  you already have the PDF/PostScript/TIFF file loaded in the previewer.  Now
select the “Stitch...” command from the Tools menu.

Rotating
You can rotate the on screen picture in steps of 90 degrees. Picture rotations will be reset to
zero degrees if you select another picture or another file.

Select the “Rotate clockwise” command from the View menu or click the button on the
toolbar. This will rotate the current picture 90 degrees clockwise.

Select the “Rotate anti-clockwise” command from the View menu or click the button on
the toolbar. This will rotate the current picture 90-degree counter clockwise.

To rotate a picture 180 degrees, repeat either rotate command twice.

Zooming
There are several ways to zoom in on a picture. Note that each picture will initially fit the
window of the preview area.

2 DGN V7 support requires a special separate licensed module.
3 PDS requires PDSView on Windows and the GeoFrame suite on Linux/Solaris.
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Scaled Zoom
You can zoom in steps of 25%. Either select the “Scale +25%” command from the View
Zoom menu or click on the zoom in button on the toolbar.

You can zoom out in steps of 25%. Either select the “Scale -25%” command from the
View Zoom menu or click on the zoom out button on the toolbar.

You can also zoom in and zoom out by using the mouse wheel while holding the Ctrl key
pressed down.

There are also three fixed scale zoom possibilities:

• Zoom to 50%. Scale the image to half its metric size.

• Zoom to 100%. Scale the image to its metric size.

• Zoom to 200%. Scale the image to double its size.

Rectangle Zoom
The rectangle zoom allows you to zoom in on a part of the picture by dragging a rect -
angle with the mouse. Either select the “Zoom Rectangle...” command from the  View

Zoom menu or click on the rectangle zoom button on the toolbar. The cursor will change
into the Zoom cursor. Go with the mouse to the part of the picture you want to zoom in on,
and click and hold the left mouse button. Drag the mouse to the desired size of the rectangle
and let go of the mouse button.
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Page Zoom
To fit the picture to the complete preview area, select the “Whole Page” command from
the  View Zoom menu. Alternatively, click on the “Whole Page” zoom button on the

toolbar.

The page width zoom allows you to match the width of the image to the width of the pre -
view area. Select the “Page Width” command  from the View Zoom menu.

The page height zoom allows you to match the height of the image to the height of the pre-
view area. Select the “Page Height” command  from the View Zoom menu.

Shortest Side
Use this command to fit the shortest side of the picture (regardless of the metric size) to
the size of the main window. This is useful when viewing long images such as Well

Logs. Select the “Shortest Side” command from the View Zoom menu.

Full Screen
Use the  View Full Screen command to expand the main window to the entire
screen. This will  also hide the menu bar and the status bar.  Use the shortcut key to

switch back to the normal mode.
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Panning
You can pan the picture when you are zoomed in. Use the scroll bars around the preview to
pan. You can also use you mouse scroll wheel to pan vertically.

You can also switch to the mouse pan mode. Enable the mouse pan mode by either
selecting “Pan Mode” command from the View menu or click on the pan hand icon on

the toolbar.  You can now pan by clicking and holding the mouse button pressed on the
preview area. Move the mouse to pan.

Bird’s Eye View
The Bird’s Eye View gives a miniature overview window of the picture that is  currently
loaded. This is an alternative method for zooming and panning.

Select the “Bird's Eye View” command from the View menu to open or close the window.

A box frame is displayed over the miniature picture indicating the portion of the picture cur-
rently displayed in the main view area.  This box frame can be resized and displaced to
quickly move to any portion of the picture.
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Zoom in or zoom out on the picture by resizing the box frame of the Bird’s Eye View win-
dow. Use the left mouse button to click and hold one of the eight green squares of the box
frame to size the box frame. Now resize the box frame and release the mouse button to up-
date the main view window.

You can pan to another part of the picture by displacing the box frame of the Bird’s eye view
window. Use the left mouse button to click in the middle of the box frame. Hold and drag
the box frame with the mouse to another portion of the picture. Release the mouse button to
update the main view area.

View Fence
You can place a view fence on the current loaded image. This gives you more control over
what part of the image is exported or printed.

Select Edit Fence Mode from the menu bar. Now drag the rectangle fence over the
canvas. Click and hold the left mouse button. Drag the box frame to another part of the
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image while holding the mouse button. Release the mouse button to set the fence area. You
can move and size the fence area as long as you do not select another picture.

You can disable a fence by selecting Edit Fence Mode again from the menu bar.

View Selection
Both a zoomed-in area and a view fence area are used for the view selection when printing
or exporting. A view fence always takes precedence over a zoomed-in area. You have the best
control over what is saved and printed, by first zooming and panning to the area you are in-
terested in. Then place a view fence for the precise selection.

Multiple Picture CGM
JustIMAGE 5.4 allows you to browse through a multiple picture CGM. Each picture is
shown as a separate picture.  Use the  View  “Next picture” to go the next  picture

within the CGM.

The View  “Previous picture” will bring you back to the previous picture within the
CGM. The “Select picture...” from the View menu allows you to select directly a picture.

Copying to the Clipboard
You can copy the picture you see in the preview area to the clipboard. Either select the
“Copy” command from the Edit menu, or click on the copy button on the toolbar.

Note that this creates a bitmap copy of what is in the preview area.

WebCGM Hotspots
WebCGM files with interactive areas also known as hotspots can be viewed. By default only
hotspots that have a hyperlink, tool tip or a region will be visible if the mouse pointer hovers
over the interactive area. Toggle the View  Hotspots option to view all possible hotspots.
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The  cursor  will  change  into  a  pointing  finger  should  there  be  one  or  more  hyperlinks
associated with the hotspot. Clicking the mouse in the hotspot area in this case will cause the
viewer to try to open the given hyperlink. A menu will be shown if there is more than one
hyperlink associated with the hotspot.

20

Illustration 5: Circle with a WebCGM hotspot area.



Justcroft International

Making Screen Captures

Making a Screen Capture in JustIMAGE 5.4
Either click the screen capture toolbar button or select the “Screen Capture...” command
from the Tools menu. The Screen Capture dialog box will appear.

You can specify whether to capture the “Whole Screen”, the “Whole Desktop”, the active
“Window”  or  a  screen  “Area”.  Other  options  are  to  include  the  window  frame,  hide
JustIMAGE during the capture and to have the mouse cursor included in the screen capture.

The difference between “Whole Screen” and “Whole Desktop” is when you have a multi-
monitor configuration. “Whole Screen” captures only a single monitor screen of your multi-
monitor configuration. Which monitor screen is captured depends on where your mouse
cursor is located at the time of the capture. You can also force a specific monitor screen to be
captured  if  you  so  desire.  “Whole  Desktop”  will  capture  your  whole  virtual  desktop
spanning all your monitors in your monitor configuration.

You can capture either by pressing a “Hot key” or capture “Automatically” after the given
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number of seconds (0–60) has passed. The cursor will change into a cross hair if the “Area”
option was selected. Press and hold the left mouse button and drag to select the area, then
release the left mouse button.

A screen capture can be to a file, the clipboard or to both a file and the clipboard. The file will
be generated in the “Output Directory”. The default is to use your “My Pictures” directory.
Use the browse button to change the directory.

The format of the generated file can be “CGM Version 3”, “CGM Version 1”,  PNG,  JPEG,
BMP,  TIFF or WebP. You should not use “CGM Version 3” or “CGM Version 1” if you want
to import screen captures (also) into applications other than  JustIMAGE 5.4. Select “CGM
Version 1” if you have an older type of CGM application.

You can control the image quality of JPEG and  WebP files. Higher values means a better
quality, but with a larger file size. Select “default” for the best balance between image quality
and file size.

You can set a fixed output file name, use some time stamp pattern or a sequence number
pattern. The default is:  justcapt_%Y%m%d_%H%M%S. This will generate a file name with a
time stamp, such as justcapt_20071115_123620. Pattern syntax: %d = day, %m = month,
%Y = year,  %H = hour, %M = minutes,  %S = seconds, %% = %, # = sequence number digit. Use
multiple # to specify a sequence number. For example, ### will result in the sequence 001,
002, etc. The file name extension is automatically added depending on the selected output
format.

Press  Capture to start the capture.  Press  Cancel to abort.  To reset the settings to their
defaults,  press  Restore   Defaults.  During  the  capture  process  you  can  press  the
“Cancel key” if you want to abort the capture.

The capture you make will automatically appear in the preview area.

Making a Screen Capture in JustMONTAGE
You can make a screen capture and insert this  on the canvas.  Either  click the screen
capture toolbar button or select the “Screen Capture...” command from the Insert menu.

The Screen Capture dialog box will appear.
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You can specify whether to capture the “Whole Screen”, the “Whole Desktop”, the active
“Window”  or  a  screen  “Area”.  Other  options  are  to  include  the  window  frame,  hide
JustMONTAGE during the capture and to have the mouse cursor included in the screen
capture.

The difference between “Whole Screen” and “Whole Desktop” is when you have a multi-
monitor configuration. “Whole Screen” captures only a single monitor screen of your multi-
monitor configuration. Which monitor screen is captured depends on where your mouse
cursor is located at the time of the capture. You can also force a specific monitor screen to be
captured  if  you  so  desire.  “Whole  Desktop”  will  capture  your  whole  virtual  desktop
spanning all your monitors in your monitor configuration.

You can capture either by pressing a “Hot key” or capture “Automatically” after the given
number of seconds (0–60) has passed. The cursor will change into a cross hair if the “Area”
option was selected. Press and hold the left mouse button and drag to select the area, then
release the left mouse button.

Press  Capture to start the capture.  Press  Cancel to abort.  To reset the settings to their
defaults,  press  Restore   Defaults.  During  the  capture  process  you  can  press  the
“Cancel key” if you want to abort the capture.

The rest of the procedure is the same as inserting an image once the capture has been made.

Making a Screen Capture in JustEDIT
You can make a screen capture and insert this in the CGM you are editing. Either click the
screen capture toolbar button or select the “Screen Capture...” command from the Insert
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menu. The Screen Capture dialog box will appear.

You can specify whether to capture the “Whole Screen”, the “Whole Desktop”, the active
“Window” or a screen “Area”. Other options are to include the window frame, hide JustEDIT
during the capture and to have the mouse cursor included in the screen capture.

The difference between “Whole Screen” and “Whole Desktop” is when you have a multi-
monitor configuration. “Whole Screen” captures only a single monitor screen of your multi-
monitor configuration. Which monitor screen is captured depends on where your mouse
cursor is located at the time of the capture. You can also force a specific monitor screen to be
captured  if  you  so  desire.  “Whole  Desktop”  will  capture  your  whole  virtual  desktop
spanning all your monitors in your monitor configuration.

You can capture either by pressing a “Hot key” or capture “Automatically” after the given
number of seconds (0–60) has passed. The cursor will change into a cross hair if the “Area”
option was selected. Press and hold the left mouse button and drag to select the area, then
release the left mouse button.

Press  Capture to start the capture.  Press  Cancel to abort.  To reset the settings to their
defaults,  press  Restore   Defaults.  During  the  capture  process  you  can  press  the
“Cancel key” if you want to abort the capture.

The rest of the procedure is the same as inserting an image once the capture has been made.

The Standalone Screen Capture Tool
A  standalone  screen  capture  tool  can  be  found  under  Start  Justcroft  JustIMAGE
5.4Screen Capture on Windows and as bin/justcapt under Linux.
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You can specify whether to capture the “Whole Screen”, the “Whole Desktop”, the active
“Window” or a screen “Area”.  Other options are to include the window frame, hide the
capture tool during the capture and to have the mouse cursor included in the screen capture.

The difference between “Whole Screen” and “Whole Desktop” is when you have a multi-
monitor configuration. “Whole Screen” captures only a single monitor screen of your multi-
monitor configuration. Which monitor screen is captured depends on where your mouse
cursor is located at the time of the capture. You can also force a specific monitor screen to be
captured  if  you  so  desire.  “Whole  Desktop”  will  capture  your  whole  virtual  desktop
spanning all your monitors in your monitor configuration.

You can capture either by pressing a “Hot key” or capture “Automatically” after the given
number of seconds (0–60) has passed. The cursor will change into a cross hair if the “Area”
option was selected. Press and hold the left mouse button and drag to select the area, then
release the left mouse button.

Select the “Multi Capture” option if you want to make multiple screen captures. You can
specify the “Interval” of the captures (1–300 seconds). Using the “Hot key” will initiate the
first capture. Subsequent captures will happen automatically.
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Taking screen captures will stop depending on the selected stop method:

• end key: Pressing the End key will stop the screen capture process.

• captures:  The  screen  capture  process  will  stop  after  the  given  number  of  screen
captures.

• seconds: The screen capture process will stop after the given number of seconds. This
timing will only start after the first capture.

• minutes: The screen capture process will stop after the given number of minutes. This
timing will only start after the first capture.

Press the End key if you want to stop the multi capture earlier or to abort a single capture.

The format of the generated file(s) can be “CGM Version 3”, “CGM Version 1”, PNG, JPEG,
BMP, TIFF or WebP. You should not use “CGM Version 3” or “CGM Version 1” if you want
to import screen captures (also) into applications other than  JustIMAGE 5.4. Select “CGM
Version 1” if you have an older type of CGM application.

You can control the image quality of JPEG and  WebP files. Higher values means a better
quality, but with a larger file size. Select “default” for the best balance between image quality
and file size.

A screen capture can be to a file, the clipboard or to both a file and the clipboard. The file will
be generated in the “Output Directory”. The default is to use your “My Pictures” directory.
Use the browse button to change the directory.

You can set a fixed output file name, use some time stamp pattern or a sequence number
pattern. The default is:  justcapt_%Y%m%d_%H%M%S. This will generate a file name with a
time stamp, such as justcapt_20071115_123620. Pattern syntax: %d = day, %m = month,
%Y = year,  %H = hour, %M = minutes,  %S = seconds, %% = %, # = sequence number digit. Use
multiple # to specify a sequence number. For example, ### will result in the sequence 001,
002, etc. The file name extension is automatically added depending on the selected output
format.

Press Capture to start the capture. Press Close to abort and close the Screen Capture tool.
To reset the settings to their defaults, press Restore Defaults.
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How to Export to a Different File Type
An image can be converted into either raster based bitmaps, PDF, SVG or SVGZ from within
the JustIMAGE 5.4 Viewer interface, Edit or Montage.

You can export by selecting the “Export...” command from the File menu. Note: A more
detailed description of all the various export options of the Export dialog box is given in

the “Reference Manual”.

Exporting only a Part of the Image
Both a zoomed-in area and a view fence area can be used for the export of only a part of the
(preview) image. A view fence always takes precedence over a zoomed-in area. You have the
best control over what is saved, by first zooming and panning to the area you are interested
in. Then place a view fence for the precise selection.

Make sure that the “Current view” selection option is set in the Export
dialog  box.  This  is  by  default  selected  if  there  was  a  selection  in  the
previewer.  Selecting “Complete picture” overrides the selection and the
whole image regardless of zoomed-in area and/or view fence is used.

Creating a Bitmap
An image can be converted into BMP, GIF, JPEG, PBM, PGM, PPM, PNG or TIFF bitmap file.
Select the format you want to use from the “Format” combo box.

It  is  recommended to limit  the size of the
bitmap especially if you want to create these
for  online  publications.  Check  the  metrics
by setting the units to “Pixels”. Turn off the 
Size  as  CGM  metrics”  option  if  you  see
values  above  2048  pixels.  Make  sure  that

“Maintain  aspect  ratio”  is  enabled.  Lower  the  pixel  size  values  to  something  around
1024-1600 pixels.  Tip: Turning on the “Limit size” will  restrict the bitmap to not become
larger than the given size, but still allow it to be smaller.

Bitmaps with fine details may benefit from the “Anti alias 2x2” option. Anti aliasing reduces
visual  artifacts when rendering bitmaps at  low resolutions.  Text  and thin lines will  look
better. The disadvantage is that the bitmap will take longer to create.

We recommend to leave both “Color Mapping” and “Compression” at their default values.

Save to the selected bitmap format by pressing the Convert button. The progress indicator
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will give you some idea how long the conversion is going to take. Press the Cancel button to
abort the conversion.

Press the Cancel button (again) to close the Export dialog box if the “Close window after
successful conversion” option was not set.

Creating a PDF
Select “PDF” from the “Format” combo box. In general you can leave the “Size as CGM
metrics” option enabled as PDF is a vector format. Check that the “Resolution” is at least 300
dpi. The default is 600 dpi.

TrueType text  in  PDF output  can  be  generated  as  text
instead of being emulated. This makes text searching and
selection possible. Editing those PDF files with TrueType
text is possible with Acrobat Professional. The PDF is less
portable  if the font data is not embedded. Select “Embed

fonts” to have the font data added to the PDF. This will make the PDF larger. By using
“Subset embedded fonts” only the used characters will be stored in the PDF this will reduce
the size of the file.

WebCGM Layer information and Hotspots information are automatically added to the PDF.

You can divide a PDF image into tiles. The PDF image will be tiled along the longest side of
the input (taking the rotation into account). The length of each tile can be A4, Letter or a
custom length specified in either millimeters (Custom mm) or inches (Custom inch). Note:
This option is intended for Well Log images to make viewing and printing to sheets easier. It
can also help as a workaround for limitations of the Acrobat Reader.

Create the PDF by pressing the Convert button. The progress indicator will give you some
idea  how  long  the  conversion  is  going  to  take.  Press  the  Cancel button  to  abort  the
conversion.

Press the Cancel button (again) to close the Export dialog box if the “Close window after
successful conversion” option was not set.

Creating a SVG
Select “SVG” from the “Format” combo box and make sure that “Compression” is set to
“None”. In general you can leave the “Size as CGM metrics” option enabled as SVG is a
vector format. Check that the “Resolution” is at least 300 dpi. The default is 600 dpi.

Select “Include Itedo SVG extensions” if you want WebCGM information added to the SVG
specific for  Itedo software.  Select  “Include  Hotspots”  if  you want  WebCGM information
added to the SVG suitable for a web browser. Note that this only happens if the original file
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already had this hotspot information.

Create the SVG by pressing the Convert button. The progress indicator will give you some
idea  how  long  the  conversion  is  going  to  take.  Press  the  Cancel button  to  abort  the
conversion.

Press the Cancel button (again) to close the Export dialog box if the “Close window after
successful conversion” option was not set.

Creating a SVGZ
A SVGZ is the same as a SVG, but saved as a GNU Zip file using deflate compression. Select
“SVG” from the “Format” combo box and make sure that “Compression” is set to “Deflate”.
In general you can leave the “Size as CGM metrics” option enabled as SVGZ is a vector
format. Check that the “Resolution” is at least 300 dpi. The default is 600 dpi.

Select “Include Itedo SVG extensions” if you want WebCGM hotspot information added to
the SVGZ. Select “Include Hotspots” if you want WebCGM information added to the SVGZ
suitable for a web browser. Note that this only happens if the original file already had this
hotspot information.

Create the SVGZ by pressing the Convert button. The progress indicator will give you some
idea  how  long  the  conversion  is  going  to  take.  Press  the  Cancel button  to  abort  the
conversion.

Press the Cancel button (again) to close the Export dialog box if the “Close window after
successful conversion” option was not set.

Creating a PowerPoint File
An  image  can  be  converted  on  Windows  into  a  PowerPoint 2007  file  from  within  the
JustIMAGE 5.4 preview interface, Edit or Montage.

You can create a PowerPoint file by selecting the “Export to PowerPoint...” command
from the File menu.
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Make sure that the “Append to:” option is deselected. Note that the file is created and any file
that might already exist is overwritten.

Set under “Slide Setup” the size and orientation of the PowerPoint slides. The image quality
can be controlled as well. Higher quality settings mean better details, especially in text and
thin lines, at the expense of larger PowerPoint files and slower conversion.

Create the PowerPoint file by pressing the  Convert button. Press the  Cancel button to
abort the creation process. Your default associated application such as PowerPoint will come
up after the creation when the “Launch associated application” was selected.

Press the Cancel button (again) to close the Export to PowerPoint dialog box if the “Close
window after successful conversion” option was not set.

Creating a PowerPoint Slide
An  image  can  be  converted  on  Windows  into  a  PowerPoint 2007  slide  from  within  the
JustIMAGE 5.4 preview interface, Edit or Montage. The slide will be appended to an existing
PowerPoint file.

You can create a PowerPoint slide by selecting the “Export to PowerPoint...” command
from the File menu.
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Make sure that the “Append to:” option is selected and that you have selected an existing
PowerPoint file. Note that the file must not have been opened by another application.

Create  the  PowerPoint  slide  by  pressing  the  Convert button.  Your  default  associated
application such as PowerPoint will come up after the creation when the “Launch associated
application” was selected.

You can abort the creation process by pressing the Cancel button. This is not recommended
as the PowerPoint file might become partially corrupt.

Press the Cancel button (again) to close the Export to PowerPoint dialog box if the “Close
window after successful conversion” option was not set.
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How to Print
An image can  be  printed from within the  JustIMAGE 5.4 Viewer  interface,  JustEDIT or
JustMONTAGE.

You can print by selecting the “Print...” command from the File menu. Note: Setup of a
printer is described in the “JustIMAGE 5.4 Reference Manual”.

The Print Dialog Box

Select the printer you want to print to. Advanced users may want to adjust certain printer
specific settings by selecting the Properties button. The margins and orientation can also
be set for OS system printers by selecting the “Page Setup” button.

You can select “Print to file” if you want to print to a file. You will be prompted for the
file name.
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Copies
You can specify if you want to have multiple copies. You can use the “Repeat” option as an
alternative to copies. This option is only available if you have selected a raster roll plotter. If
the repeat value is greater then 1 the software will try to put the image a multiple number of
times on the paper in the width direction of the roll.

Selection
There are three possible printing ranges:

• Complete picture. The complete picture will be printed, regardless of whether it was
zoomed in. This is the default if you were not zoomed in while previewing.

• All pictures. Print all the pictures. Each picture is printed as a separate page (or pages
if tiling is enabled).

• Pictures.  Give  a  range  of  pictures  in  a  multi-picture  file.  Examples  are:  “1-5”,
“1,3,4,5”, “1, 3-5”.

• Current view. Print the current zoomed/fenced area of the picture.

Both a zoomed-in area and a view fence area can be used to print only a part of the
(preview) image. A view fence always takes precedence over a zoomed-in area. You
have the best control over what is printed, by first zooming and panning to the area
you are interested in. Then place a view fence for the precise selection.
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Banner

You can specify up to four lines of banner text to be printed with the file. A JustIMAGE 5.4
banner  logo  will  be  printed  as  well  if  more  than  one  line  of  banner  text  is  specified.
Specifying a banner reduces the printable area of a sheet printer/plotter.  Each individual
printer queue can have its own banner layout.

The banner is printed on the same sheet of paper as the picture. Each banner line can contain
up to 80 characters. You can specify the following macro keywords:

$FILENAME Expands to the file name (without path).

$PATHNAME Expand to the file name including the path.

$DATE Expands to the localized date.

$TIME Expands to the localized time.

$DATETIME Expands to the localized date and time.

$PRINTER Expands to the printer queue name.

$$ Expands to $.

You can disable the banner by setting every line to blank.

Banner settings can be applied to individual print queues or to all printer queues by enabling
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the “Apply to all” toggle.

Printing to size
JustIMAGE 5.4, by default, keeps metric CGMs metric scaled 1:1. You can see the metric size
of  the  CGM  under  the  sizes  section  of  the  print  dialog  box.  You  can  toggle  between
millimeters, centimeters or inches. The sizes shown are for the width and the height of the
picture.

Typical Oil & Gas CGMs are too big to be printed on small sheet printers for Letter/A4. You
will see a warning appear on the preview window.

You can scale the picture to fit the printable area with one of the image scaling options. This
may change the metric size, so it may not always be suitable to your situation. You can scale
in the following ways:

• None. The image is not scaled.

• Fit to printable area. The image is scaled up or scaled down to fit the printable area of
the printer.

• Shrink to printable area. The image is only scaled down if it doesn't fit the printable
area of the printer. This option is not available for abstract images.

• Fit  to roll  width.  This  option is  only available on roll  plotters and causes an an-
isotropic scale. It is intended for Well Log plots for which the width of the image is
not as critical as the length. Use the “rotate” option to orientate the image correctly on
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the roll plotter.

• Custom. Specify a metric size for the image under “Custom Sizes”. You can enter
values  either  as  absolute sizes  or  as  scale  factors  if  the  image is  metric.  Abstract
images can only be specified with an absolute size. Deselect the “Maintain aspect
ratio” toggle if you want to size the width and height independently.

Note: The Print dialog comes by default with no scaling applied to the image. You can enable
the “Last used Scaling” in the Preferences dialog in which case the last used image scaling in
the Print dialog is restored when reopening the Print dialog.

Use the “Rotate” option to change the orientation of the picture on paper. Select “Best fit” for
the rotation to  let  JustIMAGE 5.4 decide  which orientation requires  the  least  amount  of
paper. You can enable the “Last used Rotate” in the Preferences dialog in which case the last
used image rotation option is restored when reopening the Print dialog.

Select the “Tile if needed option” if you want to keep the picture at the exact scale, but tiled
over multiple sheets of paper. This is also known as paneling. By default, no overlap is used
for each tile but you can specify an overlap for each tile if you wish.

The number of tiles in X (horizontal) and tiles in Y (vertical) are shown in the preview area.
Rotating the image may further reduce the number of sheets that have to be printed.
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However, you may decide that a roll plotter, if available, is a better option for this type of
print job.

iSys iTerra Mi875 
The iSys  iTerra Mi875 can be setup as a continuous roll  plotter on Windows. Check the
following if the print preview does not show the iTerra Mi875 as a roll plotter.

Select “Page Setup...”. In the Page Setup dialog box make sure that top margin and bottom
margin are both set to zero, and that the “Page Size” is set to “8.75 x 11 in”.

See also the “JustIMAGE 5.4 Reference Manual” for further configuration details.

Canon GARO Plotters
Justcroft  printer  drivers  for  Canon  GARO plotters  are  available,  but  require  a  specific
configuration. See the “JustIMAGE 5.4 Reference Manual” for further details.

Epson HTM Plotters
Justcroft printer drivers for Epson  SureColor plotters are available using the Epson  HTM
software, but require a specific configuration. See the “JustIMAGE 5.4 Reference Manual” for
further details.
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Submit to JustPLOT
A printer queue can be configured to print  the file through Justcroft's  JustPLOT system.
There are some differences in how printing works.

You cannot select “Print to file”. Instead if you have loaded a non-CGM you can choose from
three different options. The “As CGM” is in general the best option. Advanced users may
want to select the other two options. “Original” means that the  non-CGM is passed to the
JustPLOT system. It  causes the JustPLOT system to reconvert the file into a CGM before
printing. “Native” causes the file to be directly passed to the printer without any processing.
This might give better results in some cases if the non-CGM is a HP-GL/2, PDF or PostScript
file.

Important: Always use the “As CGM” option if you have stitched the image. Using the other
options will yield an incorrect printed result.

Printing use the JustIMAGE Driver
If the JustIMAGE Driver is installed you can print from any Windows application. Just select
the JustIMAGE Driver in the application.
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You will get the JustIMAGE Launcher and then you are able to make your selection.

For example, select Export to PowerPoint and you will get the Export to PowerPoint window
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Illustration 18: Select JustIMAGE Driver in Windows 
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Illustration 19: JustIMAGE Launcher
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within JustIMAGE 5.4. 

PowerPoint will be started with the created file.
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Illustration 20: JustIMAGE Export to PowerPoint

Illustration 21: PowerPoint with the created file with JustIMAGE
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How To Import Seismic Files

How To Import Seismic Files Into CorelDRAW
CorelDRAW has no direct support for importing CGM+ or CGM*PIP files. You can use the
CGM Optimiser application to split the original CGM+ or CGM*PIP file into a filtered CGM
without the seismic sections and a  TIFF file that will contain the seismic sections. You can
then recombine the filtered CGM with the TIFF file to recreate the original seismic image.

As  an  example,  we  show  you  how  to  import  our  CGM+  test  file  benseis.cgm into
CorelDRAW X3.

Converting the Seismic CGM file
Start the CGM Optimiser Interface. Select the “Filter CGM” conversion mode. By default, the
CGM Optimiser will create two (or more) output files in the output directory:

• A filtered CGM file without any seismic sections. The file name has a percentage
sign (%) appended and the file extension .cgm. Rectangles are drawn where the
original seismic sections were.

• One or more TIFF files containing seismic sections and, optionally, converted cell
arrays from the input file. The file name has a percentage sign (%) appended and
the file extension .tif.

You can alter the output names if needed.

Select the CorelDRAW profile from the Profile option menu. It is recommended to first try
the conversion with both Line joining and Fill joining enabled but with zero tolerance factors.
Later you can experiment with non-zero tolerance factors.

You may want to increase the resolution of the TIFF file. Recommended values are between
75 and 150 for background seismic sections. Higher resolution values will look better at the
expense of longer conversion times and a larger TIFF file.
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Import Conversion result into CorelDRAW
Select the Import command from the File menu. The import dialog box will appear.

Select the filtered CGM file benseis%.cgm and click on the Import button. 

If the CGM file being imported contains fonts that are not available on your system you will
get a Fonts Substitution for Missing Fonts Window.

Position the CGM image onto the drawing area. Go to the place where you want to position
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Illustration 22: The Import dialog box of CorelDRAW.

Illustration 23: The Font 
Substitution for Missing Fonts dialog
box of CorelDRAW.
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the upper left corner of the CGM image. Click and hold the left mouse button. Now drag the
mouse to the lower right corner and release the mouse button. Notice that the aspect ratio
will be retained by CorelDRAW.

Do not click and release the left mouse button immediately.  CorelDRAW will, in this case,
position the filtered CGM with its original size on the screen. The original size may not fit on
the drawing area, forcing you to move and resize the image by hand.

Select the “Ungroup All” command from the Arrange menu.

You may want to remove the rectangle that was placed by the CGM Optimiser around the
original seismic section. Select the rectangle and press the Delete key.
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The next step is to import the TIFF file into CorelDRAW. Select the “Import” command from
the File menu.

Select the benseis%.tif file and click on the Import Button. Position the TIFF image onto
the drawing area. Go to the place where you want to position the upper left corner of the
TIFF image. Click and hold the left mouse button. Now drag the mouse to the lower right
corner  and  release  the  mouse  button.  Notice  that  the  aspect  ratio  will  be  retained  by
CorelDRAW.
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The original size may not fit on the drawing area forcing you to move and resize the image
by hand.

How To Import Seismic Files Into Canvas 7
Canvas 7 has, as standard, no direct support for importing CGM+ and CGM*PIP files. You
can use the  CGM Optimiser application to split the original CGM+ or CGM*PIP file into a
filtered  CGM  without  the  seismic  sections  and  a  TIFF file  that  will  contain  the  seismic
sections. You can then recombine the filtered CGM with the TIFF file to recreate the original
seismic image.

As an example, we will show you how to import our CGM+ test file  benseis.cgm into
Canvas 7.

Converting the Seismic CGM file
Start the  CGM Optimiser. Select the “Filter CGM” conversion mode. By default, the  CGM
Optimiser will create two (or more) output files in the output directory:

• A filtered CGM file without any seismic sections. The file name has a percentage sign
(%) appended and the file extension .cgm. Rectangles are drawn where the original
seismic sections were.

• One or more  TIFF files containing seismic sections and, optionally,  converted cell
arrays from the input file. The file name has a percentage sign (%) appended and the
file extension .tif.

Select the Canvas 10/11 profile from the Profile option menu. It is recommended to first try
the conversion with both Line joining and Fill joining enabled but with zero tolerance factors.
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Later you can experiment with non-zero tolerance factors.

You may want to increase the resolution of the TIFF file. Recommended values are between
75 and 150 for background seismic sections. Higher resolution values will look better at the
expense of longer conversion times and a larger TIFF file.

Import Conversion result into Canvas 7
There are several ways to import the  CGM Optimiser result into Canvas 7. The following
method allows you to import the CGM with the original metric size using File  Open. If
you want to create a composite of multiple seismic CGM files, it is better to create a canvas
first and then use the File  Place command.

Select the File  Open command from the menu bar.
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Justcroft International

Select  the  filtered  CGM file  benseis%.cgm and click  on  the  Open button.  The  Import
Options dialog will appear. In this case, we want to retain the original metric size, so we
specify scale 100%.

Select the “Ungroup” command from the Object menu

You may want to remove the rectangle that was placed by the CGM Optimiser around the
original seismic section. Select the rectangle and press the Delete key.
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The next step is to import the  TIFF file into Canvas. Select the “Place” command from the
File menu.

Select the benseis%.tif file and click on the Place button. Position the TIFF image onto the
drawing area. Go to the place where you want to position the upper left corner of the TIFF
image. Click and hold the left mouse button. Now drag the mouse to the lower right corner,
while holding the shift button. The latter is necessary to retain the aspect ratio of the image.
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The  TIFF image is now positioned on top of the CGM image. You have to move the  TIFF
image to the background to restore the original CGM+ image. Select the TIFF image (if not
already selected). Select the “Shuffle Down” command from the Object Arrange menu.
You  can  also  right  click  on  the  image  and  select  the  “Shuffle  Down”  command  form
Arrange menu.

How To Import Seismic Files Into Canvas 11
Canvas 11 has, as standard,  direct support for importing CGM+ and CGM*PIP files. 

As an example, we will show you how to import our CGM+ test file  benseis.cgm into
Canvas 11.
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There  are  several  ways  to  import  the  CGM+  and  CGM*PIP  files  into  Canvas  11.  The
following method allows you to import the CGM with the original metric size using File 
Open. If you want to create a composite of multiple seismic CGM files, it is better to create a
canvas first and then use the File  Place command.

Select the File  Open command from the menu bar.
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Illustration 26: The File Open dialog box of Canvas 11.
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Select  the  filtered  CGM  file  benseis.cgm and  click  on  the  Open button.  The
CGM/CGM*PIP  Import  Options  dialog  will  appear.  In  this  case,  we  want  to  retain  the
original metric size, so we specify Scale Input 100%.
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Illustration 27: The CGM/CGM*PIP Import 
Options dialog box of Canvas 11.

Illustration 28: benseis.cgm loaded into 
Canvas 11.
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Select the “Ungroup” command from the Object menu

How To Import Seismic Files Into MicroStation
MicroStation has no direct support for importing CGM+ or CGM*PIP files. You can use the
CGM Optimiser application to split the original CGM+ or CGM*PIP file into a filtered CGM
without the seismic sections and a  TIFF file that will contain the seismic sections. You can
then recombine the filtered CGM with the TIFF file to recreate the original seismic image.

As  an  example,  we  show  you  how  to  import  our  CGM+  test  file  benseis.cgm into
MicroStation V8.

Some things to consider when using the CGM Optimiser for MicroStation:

• It is very important that you select the correct profile of your MicroStation version
you are using. There are subtle differences between the MicroStation SE, MicroStation
J and MicroStation V8.

• The  MicroStation  profiles  we  supply  assume  the  regular  CGM  import  filter  of
MicroStation. It could be that you use a CGM import filter supplied by a third party
that requires some tuning. See, for example, the “Escape –350” option.

• MicroStation can use, at most, 256 colors in any given design file. It is recommended
to attach the CGM Optimiser generated raster files using the raster manager.

• Cell arrays (e.g. raster data) in a CGM are, as standard, converted to separate raster
files. This is also to work around the 256 color problems.
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• The MicroStation import  filter  assumes that  one VDC unit  should be  mapped to
either  a  master  unit  or  a sub-unit.  You should set  the “VDC Unit” option to the
correct unit translation to keep the metric sizes correct. The “VDC Unit” option can
be found under the Advanced Options dialog box.

Converting the Seismic CGM file
Start the CGM Optimiser Interface. Select the “Filter CGM” conversion mode. By default, the
CGM Optimiser will create two (or more) output files in the output directory:

• A filtered CGM file without any seismic sections. The file name has a percentage sign
(%) appended and the file extension .cgm. Rectangles are drawn where the original
seismic sections were.

• One or more  TIFF files containing seismic sections and, optionally,  converted cell
arrays from the input file. The file name has a percentage sign (%) appended and the
file extension .tif.

You can alter the output names if needed.

Select the “MicroStation V8” profile option. It is recommended to first try the conversion
with both Line joining and Fill joining enabled but with zero tolerance factors. Later you can
experiment with non-zero tolerance factors.

Make sure that the raster output is “TIFF-Deflate”. This is needed since the raster manager of
MicroStation  V8  does  not  support  LZW  compression.  You  may  want  to  increase  the
resolution of the  TIFF file. Recommended values are between 75 and 150 for background
seismic sections. Higher resolution values will look better at the expense of longer conversion
times and a larger TIFF file.

Import Conversion result into MicroStation
Select the  Import CGM command from the  File menu. The Open Computer Graphics
Metafile dialog box will appear.
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Select the filtered CGM file  benseis%.cgm and click on the OK button. The Import CGM
File dialog box will appear.

You can control the import process with the options you find under the Settings menu.  The
MicroStation defaults are used in this example. Click the Open button to start the import
process. Wait until the import process has finished and click the “Fit View” button to make
the image completely visible.

You may want to remove the rectangle that was placed by the CGM Optimiser around the
original seismic section. Select the rectangle and press the Delete key.
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Illustration 29: The Open CGM dialog box of MicroStation.

Illustration 30: The Import CGM File dialog box of 
MicroStation.
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The next step is to add the  TIFF file into MicroStation. Select the Raster Manager from the
File menu. The Raster Manager dialog box will appear.

Select from the Raster Manager dialog box the File Attach command. The Attach Raster
Reference dialog box will appear.

Select the  benseis%.tif file and click on the  OK button. Note that the Raster Manager
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Illustration 31: The Attach Raster Reference dialog box of 
MicroStation.
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allows you  to  place  the  raster  image  interactively.  It  is  usually  a  good idea  to  roughly
position the raster image first.

Go to the place where you want to position the upper left corner of the TIFF image. Click and
hold the left mouse button. Now drag the mouse to the lower right corner and release the
mouse button. Notice that MicroStation will retain the aspect ratio.

The TIFF image is automatically positioned under the CGM vector data.

You may want to fine-tune the position and size of the TIFF image. You can do this by double
clicking the  benseis%.tif file from within the Raster Manager. Select the Location tab
from the Raster Settings dialog box.
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How To Import Seismic Files Into PowerPoint 2010
Microsoft PowerPoint 2010 has no direct support for importing CGM+ or CGM*PIP files. You
can use the  CGM Optimiser application to split the original CGM+ or CGM*PIP file into a
filtered  CGM  without  the  seismic  sections  and  a  TIFF file  that  will  contain  the  seismic
sections. You can then recombine the filtered CGM with the TIFF file to recreate the original
seismic image.

As  an  example,  we  show  you  how  to  import  our  CGM+  test  file  benseis.cgm into
Microsoft PowerPoint 2010.

Converting the Seismic CGM file
Start the CGM Optimiser Interface. Select the “Filter CGM” conversion mode. By default, the
CGM Optimiser will create two (or more) output files in the output directory:

• A filtered CGM file without any seismic sections. The file name has a percentage sign
(%) appended and the file extension .cgm. Rectangles are drawn where the original
seismic sections were.

• One or more  TIFF files containing seismic sections and, optionally,  converted cell
arrays from the input file. The file name has a percentage sign (%) appended and the
file extension .tif.

You can alter the output names if needed.
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Select the Office 2007/2010 profile from the Profile option menu. It is recommended to first
try the conversion with both Line joining and Fill joining enabled but with zero tolerance
factors. Later you can experiment with non-zero tolerance factors.

You may want to increase the resolution of the TIFF file. Recommended values are between
75 and 150 for background seismic sections. Higher resolution values will look better at the
expense of longer conversion times and a larger TIFF file.

Import Conversion result into PowerPoint 2010
Select the “Picture” command from the Insert menu. The import dialog box will appear.

Select the filtered CGM file  benseis%.cgm and click on the Insert button. The CGM image
will  be  positioned on the drawing area.  Notice that  the aspect  ratio  will  be retained by
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PowerPoint.

Select the Group command from the Format tab. Within the Group menu select the Ungroup
command.

You will get a PowerPoint message, select the Yes button.

Sometimes it is necessary to Ungroup a couple of times.
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The next step is to import the TIFF file into PowerPoint. Select the Picture command from the
Insert menu. The import dialog box will appear.

Select the  benseis%.tif file and click on the Insert Button. Resize the  TIFF image and
position the  image onto the drawing area. Select the rectangle which was drawn where the
original seismic sections were.
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Illustration 34: Inserting the TIFF image into PowerPoint.
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Select the “Align” command from the Format tab. Within the Group menu select the “Align
Top” command.

Select the “Align” command from the Format tab. Within the Group menu select the “Align
Right” command.
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Select  only  the  seismic  section  and  move  the  lower  left  corner  to  the  lower  left  of  the
rectangle.

The Seismic section is now positioned on top of the CGM image. You have to move the
Seismic section to the background to restore the original CGM+ image. Select the seismic
section and with the right mouse click select Send to Back  Send to Back.
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Adobe Illustrator

Introduction
This  chapter  is  intended  for  users  who  want  to  import  JustIMAGE files  into  Adobe
Illustrator. It explains the workflow on how to export from JustIMAGE and how to use the
layers within Adobe Illustrator. Adobe Illustrator is a vector graphics editor developed and
marketed by Adobe Inc. The examples in this chapter are created with Adobe Illustrator CC
2018.

Adobe Illustrator CGM support
You can bring images into Adobe Illustrator using the File  Open→  command.

Illustrator has limited CGM import support. Some simple CGM files can be imported but
often you get the following error message. 

Adobe Illustrator PDF support
Adobe Illustrator has  PDF import support which seems to be a lot better than the  CGM
import.
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JustIMAGE PDF export
You can bring images into JustIMAGE using the File  Open→  command.

Use the File  Export → command to create the vector PDF file.

Make sure the “True Type text” box has been selected.
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Editing PDF in Adobe Illustrator
You can bring images from PDF files into Adobe Illustrator using the Open command, the
Place command,  the  Paste command,  and  the  drag-and-drop  feature.  Use  the  Place
command with the Link option selected to import a PDF file (or one page of the PDF if it is a
multi-page document) as a single image.

Once the PDF file is imported in the program, click on the "Windows" and select Layers to
show the Layers window. 

All the elements are visible but unfortunately only on one layer (Layer 1  <Clip Group>).→
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In the Layers panel, click the name of the layer above which (or in which) you want to add
the new layer. Select the element in the Layers panel and drag and drop it to the matching
layer.

When all the elements are on the correct layers you can save the image as an AI file.
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Batch Processor
The Batch Processor allows you to convert multiple files in one run. The Batch Processor
runs independently from the JustIMAGE 5.4 User Interface so that you can continue working
while the Batch Processor is running. You can start the Batch Processor in the JustIMAGE 5.4
User Interface by selecting the “Batch Processor” command from the Tools menu.

The following processing types are possible:

• Convert to CGM. Convert one or more files to a CGM.

• Convert to non-CGM. Convert one or more files to a bitmap, PDF or SVG.

• Optimise files. Perform line joining and fill joining on the specified files.

• Process  for  graphics  applications.  Run the CGM Optimiser  to import files into a PC
drawing package. Split CGM+, CGM*PIP into a normal vector CGM and a raster file
for the seismic.
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• Merge PDFs. Merge two or more PDF files into a single multi-page PDF.

• Print files. Print multiple files.

Important: One or more processing types might be disabled if you do not have one of the
following module licenses:  Input  File  Converter  module,  Output  File  Converter  module,
Printing modules and CGM Optimiser module.

The Batch Processor shares some of the settings with JustIMAGE 5.4. Shared settings will be
saved if you press Finish after the batch run. Shared settings are:

• CGM Optimiser specific settings. 

• Color redefinition. 

• Advanced raster settings such as Anti Alias 2x2.

Input file selection mode
For all options except the Merge PDFs option it is to possible to choose between the normal
file selection and the hot directory mode.

Normal mode
Enter the files you want to process in the “Files to Process” screen.
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You must specify at least one file before you can continue. Press the Add button to open a file
selection dialog box. You can select multiple files at the same time from the file selection
dialog box.

Select one or more entries from the list and press the Remove button to remove any files from
the conversion. Click on Next > to continue.

Hot directory mode
Specify here the directory from which the Batch Processor will pick up files for processing.
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If  the  files  need to  be kept after  processing you can use the option “Move input file to
directory after processing”. The files will then be placed in the specified directory.

Convert to CGM
Select “Convert to CGM” in the Welcome screen of the Batch Processor and click on Next 

Select the input files using the normal file selection mode or the hot directory mode  and
click on Next > to continue.

Enter in the “File Output” screen the output destination. The default is to create output files
in the same directory as the input file. By selecting the “Other” option, a directory for the
output file(s) can be selected.
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The “Allow output overwrite” option can be turned off if you want to prevent file overwrite
during the conversion. Click on Next > to continue.

You will get the Converter options screen.

75

Illustration 40: The Converter options screen of the 
Batch Processor.

Illustration 39: The File Output screen of the Batch 
Processor.



Batch Processor

You can set if necessary conversion options, but in general you can leave this alone. Click on
Next > to continue.

You will first get a summary of the processing options you had specified in the previous
screens. If needed you can log extra information.

Processing can be started immediately or at the specified time. The time should be specified
in hours and minutes.

Press the  Next > button to start the actual conversion process. Press the < Back button if
you want to make changes to the options you had selected.
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The Run window shows you the progress of the batch conversion. The progress bar gives
you an indication of how many files are converted so far. Information is shown about the
current file that is being processed.

The log summary keeps track of the batch process. You can find here information about the
success  or  failure  of  a  specific  job.  You  can  view this  log  after  the  Batch  Processor  has
finished by pressing the Log... button.

Press Cancel if you want to abort the batch conversion run. You will be prompted whether
you are sure you want to abort the process.

Important: Processing is not immediately aborted. The Batch Processor will always finish the
current processing job first.

Convert to Non-CGM
Select “Convert to non-CGM” in the Welcome screen of the Batch Processor and click on
Next >.

Select the input files using the normal file selection mode or the hot directory mode and click
on Next > to continue.
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Enter in the “File Output” screen the output destination. The default is to create output files
in the same directory as the input file. By selecting the “Other” option, a directory for the
output file(s) can be selected.

The “Allow output overwrite” option can be turned off if you want to prevent file overwrite
during the conversion. 

Select from the “Format” combo box the format of the output. An image can be converted
into BMP, GIF,  JPEG, PBM, PGM, PPM, PDF, PNG, SVG or TIFF. Select the SVG format to
create a SVGZ. The generation of SVGZ is controlled on the “Convert to non-CGM Options”
screen later on in the wizard.

You can filter files through the CGM Optimiser if PDF or SVG is selected as output format.

Select the Resolution of the (raster) output file to be generated. Higher resolution gives better
graphics details, however this will cost more memory and the conversion will take longer.
PDF and SVG will support much higher resolutions since these are vector formats.

The “Raster memory” setting controls the maximum amount of cache memory to use for
rendering seismic sections. You can raise this value if you have large amounts of physical
memory in your computer and you want to have better performance.

With the “Rotation” option the output can be rotated 0, 90, 180 or 270 degrees.

You can use the CGM Optimiser in combination with PDF or  SVG/SVGZ output to reduce
the file size by selecting the “Optimiser files” option.

Click on Next > to continue.
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You will get the converter options screen first if you had selected one or more non-CGM files.
You can set if necessary conversion options, but in general you can leave this alone. Click on
Next > to continue.

Adjust if necessary the color redefinition. You can revert to the default color redefinition
settings by pressing the Reset button. You can select the following options:

• Color mode. Select the color mode of the picture. The default mode is color and in
this mode all colors stay unmodified. If gray scale is selected all colors are converted
to a gray value.  The Black/White option converts  all  colors  not  equal  to white to
black.

• Invert Black/White. Invert Black and White in the original image. This is useful if an
image is created with a Black background and White as the foreground color.

• Gamma correction. Adjust the Red, Green and Blue gamma values to compensate for
the non-linear reaction of your eyes to colors. The default is 1.00, which means no
adjustment. Specify higher values to increase the intensity of the color component.
Specify  lower  values  to  decrease  the  intensity.  Disabling  the  “Adjust  all”  option
allows you to adjust the individual gamma values.

Set the Color Redefinition options you want to use and click on Next > to continue.
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In the size section, you can control the size of the output file. For a metric CGM, the default
size will be the same as the size of the CGM (this is after rotation). If you disable the “Size as
CGM metrics” option, the size (horizontal x vertical) can be changed. Abstract CGMs will get
a size of 1000x1000 pixels by default, which can be changed.

Sizes can be specified in millimeters, inches or pixels depending on the value of the Metrics
option menu. If you change one of the size fields the other is updated as well (after losing
focus or pressing enter) so as to maintain the aspect ratio. The aspect ratio can be forced to
an-isotropic by disabling the “Maintain aspect ratio” option.

The “Limit size” option prevents  images becoming larger than the specified size.  This is
intended if you are creating a series of exports and you don't want images that are “blown
up” too large.

We recommend leaving “Color  Mapping” at  the default  value.  The type of  compression
depends on the image format selected. If you want a SVG file make sure that “Compression”
is set to “None”. If you want a SVGZ file make sure that “Compression is set to “Deflate”.

The quality of the JPEG files can be controlled. A higher value normally gives better quality
then a lower value but the files will be bigger. The default value is 75 and should be good
enough in most cases.

The level  for the Deflate compression (PDF,  PNG,  SVGZ and  TIFF) can be controlled. A
higher value normally gives a smaller file but it takes more time to create the file. The value
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“default” gives the best trade-of between speed and compression.

Bitmaps with fine details may benefit from the “Anti alias 2x2” option. Anti aliasing reduces
visual  artifacts when rendering bitmaps at  low resolutions.  Text  and thin lines will  look
better. The disadvantage is that the bitmap will take longer to create.

TrueType text in PDF output can be generated as text instead of being emulated. This makes
text  searching  and  selection  possible.  The  PDF  is  less  portable  if  the font  data  is  not
embedded. Select “Embed fonts” to have the font data added to the PDF. This will make the
PDF larger.

The “Include Itedo SVG extensions” is an advanced option which will add WebCGM meta
information in the SVG/SVGZ file. WebCGM  Layer information and  Hotspots information
are automatically added to the PDF.

The Seismic Resolution is used for the bitmap conversion of Seismic Background sections
when generating PDF or SVG/SVGZ. The default value of 150dpi is normally good enough.

You can divide a  PDF image into tiles. The PDF will be tiled along the longest side of the
input (taking the rotation into account). The length of each tile can be A4, Letter or a custom
length specified in either millimeters (Custom mm) or inches (Custom inch)

Click on Next > to continue.

You will first get a summary of the processing options you had specified in the previous
screens. If needed you can log extra information.
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Processing can be started immediately or at the specified time. The time should be specified
in hours and minutes.

Press the  Next > button to start the actual conversion process. Press the < Back button if
you want to make changes to the options you had selected.

The Run window shows you the progress of the batch conversion. The progress bar gives
you an indication of how many files are converted so far. Information is shown about the
current file that is being processed.

The log summary keeps track of the batch process. You can find here information about the
success  or  failure  of  a  specific  job.  You  can  view this  log  after  the  Batch  Processor  has
finished by pressing the Log... button.

Press Cancel if you want to abort the batch conversion run. You will be prompted whether
you are sure you want to abort the process.

Important: Processing is not immediately aborted. The Batch Processor will always finish the
current processing job first.

82

Illustration 47: Converting files to non-CGM run 
screen.



Justcroft International

Optimise Files
Select “Optimise files” in the Welcome screen of the Batch Processor and click on Next >.

Select the input files using the normal file selection mode or the hot directory mode and click
on Next to continue.

The “Allow output overwrite” option can be turned off if you want to prevent file overwrite
during the conversion. Click on Next > to continue.

You will get the converter options screen first if you had selected one or more non-CGM files.
You can set if necessary conversion options, but in general you can leave this alone. Click on
Next > to continue.
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In general,  you can leave the join options in the CGM Optimiser Options screen at their
default values. See the “CGM Optimiser” chapter in the Reference Manual for details on
what these options can do. Click on Next > to continue.

You will first get a summary of the processing options you had specified in the previous
screens. If needed you can log extra information.
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Processing can be started immediately or at the specified time. The time should be specified
in hours and minutes.

Press the Next > button to start the actual optimization process. Press the < Back button if
you want to make changes to the options you had selected.
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The Run window shows you the progress of the batch optimization. The progress bar gives
you an indication of how many files are optimized so far. Information is shown about the
current file that is being processed.

The log summary keeps track of the batch process. You can find here information about the
success  or  failure  of  a  specific  job.  You  can  view this  log  after  the  Batch  Processor  has
finished by pressing the Log... button.

Press  Cancel if  you  want  to  abort  the  batch  optimization  run.  You  will  be  prompted
whether you are sure you want to abort the process.

Important: Processing is not immediately aborted. The Batch Processor will always finish the
current processing job first.

Process for Graphics Applications
Select “Process for graphics applications” in the Welcome screen of the Batch Processor and
click on Next >.

Select the input files using the normal file selection mode or the hot directory mode and click
on Next > to continue.
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Enter in the “File Output” screen the output destination. The default is to create output files
in the same directory as the input file. By selecting the “Other” option, a directory for the
output file(s) can be selected.

The “Allow output overwrite” option can be turned off if you want to prevent file overwrite
during the conversion. Click on Next > to continue.

Select from the “Format” combo box the format of possible bitmap output for CGM Cell
Arrays and/or Seismic sections within the original CGM. The conversion can be BMP, GIF,
JPEG, PNG or TIFF.

Select the Resolution of the (raster) output file to be generated. Higher resolution gives better
graphics details, however this will cost more memory and the conversion will take longer.

The “Raster memory” setting controls the maximum amount of cache memory to use for
rendering seismic sections. You can raise this value if you have large amounts of physical
memory in your computer and you want to have better performance.

With the “Rotation” option the output images can be rotated 0, 90, 180 or 270 degrees.

You will get the converter options screen first if you had selected one or more non-CGM files.
You can set if necessary conversion options, but in general you can leave this alone. Click on
Next > to continue.
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Select  under  “Profile”  the  application  into  which  you  want  to  load the  CGM image.  In
general, you can leave the options in the CGM Optimiser Options screen at their default
values. See the “CGM Optimiser” chapter in the Reference Manual for details on what these
options can do. Click on Next > to continue.

You will first get a summary of the processing options you had specified in the previous
screens. If needed you can log extra information.

88

Illustration 53: The CGM Optimiser options screen
of the Batch Processor.



Justcroft International

Processing can be started immediately or at the specified time. The time should be specified
in hours and minutes.

Press the Next > button to start the actual optimization process. Press the < Back button if
you want to make changes to the options you had selected.
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The Run window shows you the progress of the batch process. The progress bar gives you an
indication of how many files are optimized so far. Information is shown about the current
file that is being processed.

The log summary keeps track of the batch process. You can find here information about the
success  or  failure  of  a  specific  job.  You  can  view this  log  after  the  Batch  Processor  has
finished by pressing the Log... button.

Press  Cancel if  you  want  to  abort  the  batch  optimization  run.  You  will  be  prompted
whether you are sure you want to abort the process.

Important: Processing is not immediately aborted. The Batch Processor will always finish the
current processing job first.

Merging PDFs
Select “Merge PDFs” in the Welcome screen of the Batch Processor and click on Next >.
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If not already set, than the merge output file is assumed to be the same directory with the file
name cgmbatch.pdf. Alter the output file name and path if needed.

Use the Up and Down buttons to change the order in which the files are merged. Note that the
order is from top to bottom. You can also sort the PDFs by clicking the Sort... button.
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You will first get a summary of the processing options you had specified in the previous
screens. If needed you can log extra information.

Processing can be started immediately or at the specified time. The time should be specified
in hours and minutes.

Press the Next > button to start the actual merging process. Press the < Back button if you
want to make changes to the options you had selected.
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The Run window shows you the progress of the merge process.  Merging happens in one or
more phases. The progress bar gives you an indication of how long it will take.

The log summary keeps track of the merging process. You can find here information about
the success or failure of a specific job. You can view this log after the Batch Processor has
finished by pressing the Log... button.

Press Cancel if you want to abort the merging process. You will be prompted whether you
are sure you want to abort the process.

Important: Processing is not immediately aborted. The Batch Processor will always finish the
current merge phase first.

Printing Files
Select “Print files” in the Welcome screen of the Batch Processor and click on Next >.

Select the input files using the normal file selection mode or the hot directory mode and click
on Next > to continue.

You will get the converter options screen first if you had selected one or more non-CGM files.
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You can set, if necessary, conversion options, but in general you can leave this alone. Click on
Next > to continue.

Select the printer you want to print to. Advanced users may want to adjust certain printer
specific settings by selecting the “Properties...” button. Use “Page Setup...” for setting the
printer (hardware) margins and page orientation.

You can select “Print to file” if you want to print to a file. You will be prompted for the
output directory in a later screen (File Output). Each printer file will have the same name as
the input file with the file extension .prn.

A printer queue can be configured to print  the file through Justcroft's  JustPLOT system.
There are some differences in how printing works. You cannot select “Print to file”. Instead if
you have loaded a non-CGM you can choose from three different options. The “As CGM” is
in  general  the  best  option.  Advanced  users  may  want  to  select  the  other  two  options.
“Original”  means  that  the  non-CGM  is  passed  to  the  JustPLOT  system.  It  causes  the
JustPLOT system to reconvert the file into a CGM before printing. “Native” causes the file to
be directly passed to the printer without any processing. This might give better results in
some cases if the non-CGM is a HP-GL/2, PDF or PostScript file.

JustIMAGE 5.4, by default, keeps metric CGMs metric scaled 1:1. You can see the metric size
of  the  CGM  under  the  sizes  section  of  the  print  dialog  box.  You  can  toggle  between
millimeters, centimeters or inches. The sizes shown are for the width and the height of the
picture.
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Typical Oil & Gas CGMs are too big to be printed on small sheet printers for Letter/A4. You
can scale the picture to fit the printable area with one of the image scaling options. This may
change the metric size, so it may not always be suitable to your situation. You can scale in the
following ways:

• None. The image is not scaled.

• Fit to printable area. The image is scaled up or scaled down to fit the printable area of
the printer.

• Shrink to printable area. The image is only scaled down if it doesn't fit the printable
area of the printer. This option is not available for abstract images.

• Fit  to roll  width.  This  option is  only available on roll  plotters and causes an an-
isotropic scale. It is intended for Well Log plots  for which the width of the image is
not as critical as the length. Use the “rotate” option to orientate the image correctly on
the roll plotter.

• Custom. Specify a metric size for the image under “Custom Sizes”. You can enter
values  either  as  absolute sizes  or  as  scale  factors  if  the  image is  metric.  Abstract
images can only be specified with an absolute size. Deselect the “Maintain aspect
ratio” toggle if you want to size the width and height independently.

Use the “Rotate” option to change the orientation of the picture on paper. Select “Best fit” for
the rotation to let Batch Processor decide which orientation requires the least amount of
paper. 

Select the “Tile if needed option” if you want to keep the picture at the exact scale, but tiled
over multiple sheets of paper. This is also known as paneling. By default, no overlap is used
for each tile but you can specify an overlap for each tile if you wish.

The number of tiles in X (horizontal) and tiles in Y (vertical) are shown in the preview area.
Rotating  the  image  may  further  reduce  the  number  of  sheets  that  have  to  be  printed.
However, you may decide that a roll plotter, if available, is a better option for this type of
print job.

You can specify if you want to have multiple copies. You can use the “Repeat” option as an
alternative to copies. This option is only available if you have selected a raster roll plotter. If
the repeat value is greater than 1, the software will try to put the image a multiple number of
times on the paper in the width direction of the roll.

You will get the converter options screen first if you had selected one or more non-CGM files.
You can set, if necessary, conversion options but in general you can leave this alone. Click on
Next > to continue.
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Adjust, if necessary, the color redefinition. You can revert to the default color redefinition
settings by pressing the Reset button. You can select the following options:

• Color mode. Select the color mode of the picture. The default mode is color and in
this mode all colors stay unmodified. If gray scale is selected all colors are converted
to a gray value.  The Black/White option converts  all  colors  not  equal  to white to
black.

• Invert Black/White. Invert Black and White in the original image. This is useful if an
image is created with a Black background and White as the foreground color.

• Gamma correction. Adjust the Red, Green and Blue gamma values to compensate for
the non-linear reaction of your eyes to colors. The default is 1.00, which means no
adjustment. Specify higher values to increase the intensity of the color component.
Specify  lower  values  to  decrease  the  intensity.  Disabling  the  “Adjust  all”  option
allows you to adjust the individual gamma values.

Set the Color Redefinition options you want to use and click on Next > to continue.

You will first get a summary of the processing options you had specified in the previous
screens. If needed you can log extra information.
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Printing can be done immediately or at the specified time. The time should be specified  in
hours and minutes.

Press the  Next > button to start the actual print process. Press the  < Back button if you
want to make changes to the options you had selected.
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The Run window shows you the progress of the batch print process. The progress bar gives
you an indication of how many files have been printed so far. Information is shown about
the current file that is being processed.

The log summary keeps track of the batch print process. You can find here information about
the success or failure of a specific job. You can view this log after the Batch Processor has
finished by pressing the Log... button.

Press  Cancel if  you  want  to  abort  the  batch  print  process  run.  You  will  be  prompted
whether you are sure you want to abort the process.

Important: Printing is not immediately aborted. The Batch Processor will always finish the
current print job first.
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JustMONTAGE
You can  start  the  JustIMAGE 5.4 montage  tool  in  the  JustIMAGE 5.4 User  Interface  by
selecting the “JustMONTAGE...” command from the Tools menu.

Introduction to the JustMONTAGE User Interface

The main window of the JustMONTAGE User Interface has a menu bar that gives you access
to  all  the  commands  of  the  JustMONTAGE Graphical  User  Interface.  Most  common
commands can be quickly accessed through the Toolbar, Zoom bar, Draw bar, Format bar,
etc. You can show or hide the individual bars and toolboxes.

The  JustMONTAGE User  Interface  will  appear  differently  depending on  the  OS  and
Window  manager  used.  User  preferences  of  JustMONTAGE can  be  controlled  by

selecting the Edit Preferences... command from the menu bar.
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Layout

Composition
The white area within JustMONTAGE is called the canvas. The canvas has a metric size and
consists of objects you place on the canvas. The layout of these objects on the canvas is called
the composition.

Compositions are saved as an XML file.  You can generate from the composition a single
CGM which is the composition CGM. You can then print or export this composition CGM to
another graphics format.

Layers
A layer is a transparent level object on which shapes are placed. On a canvas you might have
one or more layers. Layers can help you work efficiently. You can use layers to organize
similar shapes together.

Shapes
A shape is an object that is placed on a layer. Lines, ellipses and rectangles are examples of
shapes. Shapes have a position and occupy a rectangular area on the canvas. Shapes can be
assigned properties such as fill color, line color, etc.

An  image  is  a  special  kind  of  shape  that  represents  a  graphics  file,  such  as  a  CGM.
JustMONTAGE will show a bitmap representation of the graphics file as a reference for you
to work with. You cannot edit individual elements of the image, however you can change the
size, crop and rotate the image.

The image you see on the canvas is only a representation. The CGM is merged with the
composition CGM.

Control handles are small boxes that appear on a shape when you select it. For shapes such
as lines or poly-lines, the control handles are placed on each vertex of the shape. This allows
the user to move these vertices to change the layout of the shape.

Shape Selection
By default, JustMONTAGE starts in selection mode. If you are not in selection mode, you
can switch to it by deselecting the “Pan Mode” from the View menu or deselect the pan

tool button.

To select a single shape click on it whilst selection mode is activated. To select multiple
shapes, hold the Ctrl key and then click each of the shapes you want to include in the

selection.

100



Justcroft International

An alternative for holding the  Ctrl key is to use the  Format Select Multiple
Shapes mode.

Another way to make a selection is to use the fence mode. Select  Edit Fence Mode
from the menu bar. Now drag the rectangle fence over the canvas. Next use the  Edit

Select All command to select all the editable objects within the fence.

Use the Edit Select All command to select all the editable shapes on the canvas.

Moving Shapes
When JustMONTAGE is in selection mode, selected shapes can be moved by clicking them
and dragging the mouse.

When you place the pointer over a shape that you can move, the mouse pointer changes to a
“can move” pointer. If the “Snap To Grid” option is enabled, the top left corner of the shape's
bounding box aligns with the grid.

Nudging
You can do slight moves of shapes with the nudge operations. Select the shapes you want to
nudge. Either use one of the nudge directions or use the cursor keys.

Note: The nudge amount is, by default,  2 pixels, but this can be changed from the Align
toolbar and under Edit Preferences...Grid.

Aligning Shapes
You can line up shapes using the alignment operations. First select the shapes you want to
align. The last selected element automatically becomes the control element. If needed, use the
Ctrl key to select which is the control element. Next select one of the alignment actions. The
alignment is handled based on the control element.

Sizing Shapes
If a shape can be resized, the pointer turns into a directional arrow when
you  place  the  pointer  over  one  of  the  control  handles  on  the  shape.
Depending on which selection handle you select, you can either scale the
object horizontally, vertically, or both.

JustMONTAGE allows  you  to  resize  the  height,  the  width  or  both  the
height and width of a group of selected shapes. When you select a resize
button,  the  selected  shapes  automatically  grow or  shrink  to  match  the

dimensions  of  the anchor  shape,  which is  the last  shape you selected.  The thick  border
distinguishes this shape from the rest of the selected shapes.
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Grouping Shapes
You can group shapes together to form composites. Select the shapes you want to group
together and then click the Group button. Note that the selected shapes must be on the

same layer. Grouped shapes act like a single graphical shape. Any changes you make to a
group shape affects each of its contained shapes.

To  ungroup,  select  the  composite  you want  to  ungroup and then  click  the  Ungroup
button.

Locking Shapes
You can lock shapes to prevent them from being accidentally moved or sized. Select the
shapes you want to lock and then click the Lock button.

To unlock, select  the shape or shapes you want to unlock and then click the  Unlock
button.

Color Selection
The color  selection combo box allows colors  to  be  selected  from a
predefined list  of colors.   Note that  the predefined list  of  colors is
controlled  by  setting  the  color  bar from  the  Colors  tab  under  the
preference settings of  JustMONTAGE. See also the “JustIMAGE 5.4
Reference Manual, Configuration, Custom Colors” section.

Selecting the “…” entry will bring up the Select color dialog box. The Select color dialog box
allows a color to be selected in a number of ways.
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Either select one of the “Basic colors” or select a custom color using the mouse from the
palette. An alternative is to enter the values as Hue, Saturation and Value (HSV) or as Red,
Green, Blue (RGB) value. Click the “Add to Custom Colors” button to use the same custom
color another time.

Another method for selecting a color is to select a screen color. Select the pick screen color
button. The mouse will change into cross. You can now select a color by going over your
screen to sample a color. Press the mouse button to make a selection.

Make the selection and press OK to set the color. Press Cancel to abort the color change.

Zooming
There  are  several  ways  to  zoom  in  on  the  canvas.  Zooming  works  the  same  as  in  the
JustIMAGE 5.4 Viewer.

Scaled Zoom
You can zoom in steps of 25%. Either select the “Scale +25%” command from the View
Zoom menu or click on the zoom in button on the toolbar.

You can zoom out in steps of 25%. Either select the “Scale -25%” command from the
View Zoom menu or click on the zoom out button on the toolbar.

You can also zoom in and zoom out by using the mouse wheel while holding the Ctrl key
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pressed down.

There are also three fixed scale zoom possibilities:

• Zoom to 50%. Scale the canvas to half its metric size.

• Zoom to 100%. Scale the canvas to its metric size.

• Zoom to 200%. Scale the canvas to double its size.

Rectangle Zoom
The rectangle zoom allows you to zoom in on a part of the canvas by dragging a rect-
angle with the mouse. Either select the “Zoom Rectangle...” command from the  View

Zoom menu or click on the rectangle zoom button on the toolbar. The cursor will change
into the Zoom cursor. Go with the mouse to the part of the picture you want to zoom in on,
and click and hold the left mouse button. Drag the mouse to the desired size of the rectangle
and let go of the mouse button.

Page Zoom
To fit the canvas to the main window, select the “Whole Page” command from the View
Zoom menu. Alternatively, click on the “Whole Page” zoom button on the toolbar.

The page width zoom allows you to match the width of the canvas to the width of the main
window. Select the “Page Width” command from the View Zoom menu.

The page height zoom allows you to match the height of the canvas to the height of the main
window. Select the “Page Height” command from the View Zoom menu.

Shortest Side
Use this command to fit the shortest side of the canvas to the size of the main window.
This is useful when viewing long images such as Well Logs. Select the “Shortest Side”

command from the View Zoom menu.

Full Screen
Use the  View Full Screen command to expand the main window to the entire
screen. This will  also hide the menu bar and the status bar.  Use the shortcut key to

switch back to the normal mode.

104



Justcroft International

Full Pointer Cursor
Use the  View Full Pointer Cursor command to have horizontal and vertical guide
lines that cross each other where the cursor is. You may want to use this together with the
rulers to have a more precise control over where an element is positioned.

Panning
You can pan on the canvas when you are zoomed in. Use the scroll bars around the main
window to pan. You can also use you mouse scroll wheel to pan vertically.

You can also switch to the mouse pan mode. Enable the mouse pan mode by either
selecting “Pan Mode” command from the View menu or click on the pan hand icon on

the toolbar.  You can now pan by clicking and holding the mouse button pressed on the
canvas. Move the mouse to pan.

Symbols
The  symbols  toolbox  can  be  used  to  put  TrueType
font  symbols  on your  canvas.  The  symbols  toolbox
can  have  one  or  more  groups  as  in  Microsoft
Outlook®.

The  View Symbols sub-menu gives access to the
symbols toolbox.  Use the “Symbols Bar” command to
display and hide the symbols toolbox. A check mark
appears  next  to  the  menu  item  when  the  symbols
toolbox is displayed.

Initially  the  symbols  toolbox  contains  a  set  of  Well
symbols (Oil Well). To setup a symbol list,  select the
“Add symbol font…” command or right-click on the
symbols toolbox and select the “Add symbol font…”
command. In the Add Symbol Font dialog box select
the symbol font file and set an appropriate title.

To add more then one group, repeat the previous step. To remove a group, right-click a
group and select the “Remove symbol font” command.

You can drag the symbol you want to use on to the canvas. A symbol behaves like a text
element. Alter the font size to make the symbol bigger or smaller. The font color determines
the color of the symbol.

You can set a symbol as one of your favorites by right-click on the symbol and select the
“Add to favorites” command. The symbol will now be added to the Favorites group.
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The Grid
The  canvas  can  have  a  grid  to  help  you  with  the  layout  of  shapes.  Select  Edit
Preferences...Grid to bring up the default grid settings.

You can make the grid visible or invisible. You can make shapes on the canvas snap to the
grid lines. The horizontal and vertical space between grid lines can be specified. Finally, you
can specify the color of the grid marks.

The grid visibility and snap to grid can also be toggled directly via the View menu.

Composition

Creating a New Composition
To create a new composition select the “New...” command from the File menu. You can
also click the New tool button on the toolbar. Set-up the new composition you want to

create in the New Composition dialog box.
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You can select how you want to set-up your composition.

• Preset size. Select a preset canvas size from the combo box. The most common paper
sizes  are  available.  Toggle  the  Landscape  option  to  have  the  canvas  landscape
orientated.

• Custom size. Select this option if you want to specify a specific width and height for
the canvas. You can specify sizes in either millimeters, centimeters or inches.

• Template. Create a new canvas based on a template canvas.

Make your selection and press OK to create the new canvas. JustMONTAGE prompts you to
save a  composition  with  unsaved changes  before  the  new composition  is  created.  Press
Cancel to abort creating a new composition. Note: You will be able to adjust the canvas size
with the “Page Setup...” command from the File menu.

If you had selected the “Template...” option then the Select Template dialog box will appear.
Select the template which you want to use to create a new composition. Templates are either
created by you or by a colleague.
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The template author might have also provided a description of the template and his or her
name.

Either double-click the template you want to use or highlight the template and then press the
OK button. JustMONTAGE prompts you to save a composition with unsaved changes, before
the template is loaded. Press Cancel to abort the creation of a new composition.

Opening a Composition
Use the “Open...” command from the  File menu to open an existing  JustMONTAGE
composition. You will be prompted for the composition file you want to open.

Click on the  Open button to continue.  JustMONTAGE prompts you to save a composition
with unsaved changes before the selected file is opened.

You can also access the last eight used compositions directly from the File menu.

You can also load a (CGM) image for annotation.

Appending Shapes
Opening  a  composition  clears  the  current  canvas.  Use  the  File Open Append...
command to add shapes to the current active layer without clearing the canvas.

Saving your Changes
Use the “Save” command from the  File menu to save the composition to its current
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name and directory.

Use the “Save As...”  command from the  File menu to save the composition under a
different name or in a different directory. JustMONTAGE will display the Save As dialog box
so the montage file can be named.

You can also save a selection of shapes on your canvas. Select the shapes you want to save
and then use the “Save Selected...”  command from the  File menu.  JustMONTAGE will
display  the  Save  Selected  dialog  box so  that  the  montage file  with  the  selection  can  be
named.

Templates
Templates can be used by you or other users to create new compositions. Use the “Save As
Template...” command from the File menu to save the composition as a template for new
compositions. The Save As Template dialog box will appear.

Specify information about the template you want to save in this dialog box. You must specify
a title for the template. If needed, you can also specify a description and the name of the
author of the template.

You can specify if the template is only for yourself or for other JustMONTAGE users on your
PC. Note: Your system administrator might have locked down your PC, in which case you
can only save a template for yourself.
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Press the OK button to save the composition as a template. Press Cancel to abort creating a
template.

Any referenced images (such as a company logo) will also be copied to the template location.

Packages
A package is a single container file that contains the composition and all the files that are
referenced in the composition. Packages are useful when exchanging compositions between
different computers and / or users. They can also be used for archive purposes.

Important: JustMONTAGE currently uses the zip archive format for packaging purposes. It
is recommended to use only files generated by JustMONTAGE, although zip files generated
by other applications may also work.

Creating a Package
Use the “Save Package...” command from the File menu to save the active composition and
all  its  related  reference  files  to  a  single  package  file.  JustMONTAGE displays  the  Save
Package dialog box.

By default, the “File name” is the same as the current composition and we recommend not to
change it. Select the folder where you want the package file to be generated.

Press the OK button to generate the package file. Press Cancel to dismiss the dialog box.

Loading a Package
Use the “Open Package...” command from the File menu to unpack a package file and open
the composition within the package. The Open Package dialog box will appear.
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Select the “File Name” of the package. Select “Extract to” to specify the folder where the
package should be extracted.

The “Use file name as sub-folder” option is by default enabled. This ensures that all the files
are in a private sub-folder. It could be that you have already created a sub-folder specifically
for this package. In this case disable the option.

Any  existing  files  that  are  already  in  the  target  folder  are  by  default  ignored  during
extraction. You can force an update by selecting the “Overwrite existing files” option.

Press the  OK button to extract the package file. The composition file is then opened. Press
Cancel to dismiss the dialog box.

Once you have unpacked a package file, you don’t need to unpack it again as long as you did
not remove the unpack folder. Just select the composition file next time. The composition file
is also added to the file history.

The  testfiles directory  of  JustIMAGE  5.4 contains  an  example  package  montage-
example.zip.

Export
A composition can be exported to a BMP, GIF, JPEG, PBM, PGM, PPM, PNG, TIFF, PDF
or SVG file. Select the “Export...” command from the File menu. The Export dialog box

will  appear.  Note  that  layers  that  have their  visibility  turned off will  not  appear  in  the
exported file. Layers that are visible will appear as layers in an exported PDF.

Use the fence mode if you want to export only a part of the composition.

You can also export a composition to a CGM using the “Export as CGM...” command from
the File menu. You will be prompted for a CGM file name.

Note: It is not possible to export an empty composition. (The canvas contains no shapes.)
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Export to PowerPoint
A composition can be exported to a PowerPoint 2007 compatible file on Windows. Select
the “Export to PowerPoint...” command from the File menu. The Export to PowerPoint

dialog box will appear.  You can either create a PowerPoint file or add a PowerPoint slide to
an existing PowerPoint file.  Note that layers that have their visibility turned off will  not
appear in the PowerPoint file.

Use the fence mode if you want to export only a part of the composition.

Note: It is not possible to export an empty composition. (The canvas contains no shapes.)

Printing
A composition can be printed by selecting the “Print...” command from the File menu.
The Print dialog box will appear.

Use the fence mode if you want to print only a part of the composition.

Altering the Canvas Size
Use  the  File Page Setup... command to  change the  canvas  size.  The Page Setup
dialog box will appear.

You can specify the following sizes:

• Preset size. Select a preset canvas size from the combo box. The most common page
sizes  are  available.  Toggle  the  “Landscape”  option  to  have  the  canvas  landscape
orientated.

• Custom size. Select this option if you want to specify a specific width and height for
the canvas. You can specify sizes in either millimeters, centimeters or inches.
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• Auto size.  Select  this  option if  you want  to  have the  canvas size adjusted to  the
bounding box of all the shapes that are currently on the canvas. Note: The “Auto size”
option has no effect if there are no shapes on the canvas.

Make your selection and press  OK to change the canvas size.  Press  Cancel to abort  the
canvas size change.

Working With Layers
A layer is a transparent level object on which shapes are placed. On a canvas you might have
one or more layers. Layers can help you work efficiently. You can use layers to organize
similar shapes together. For example, you might use one layer for text and another layer for
images. By default, when you place a shape on the canvas, it is placed on the active layer.

A new composition has one layer (Layer 1) which is also the active layer. You can than add
more layers. You can control the visibility of the layer so that you can make separate CGMs,
prints or exports with or without the shapes of a specific layer.

Adding a New Layer
Select “Add Layer...” from the Layer menu or click on the icon in the layer toolbar. You

will be prompted for the layer name.

Note: The layer name has to be unique within the composition.

Make the layer current by highlighting the layer from the layer toolbox. Any shapes you now
insert will be added to the current (highlighted) layer.

You can move shapes between layers by selecting them, set the current layer and then use
the  “Move  selection  to  current  layer”  command  from  the  Layer menu to  move  them.
Alternatively, use copy & paste to move shapes between layers.

Changing the Layer
You can rename a layer with the “Rename Layer...” command from the Layer menu. You
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will be prompted for the new layer name.

Layers are drawn from bottom to top in the layer stack. You can move layers up and down
using the arrows in the layer toolbox or alternatively use the “Raise Layer” and “Lower
Layer” commands from the Layer menu.

Use the “eye” icon in the layer toolbox to toggle the visibility of a layer. Invisible layers
will not be visible when generating a CGM, exported or printed.

Removing a Layer
Make sure that you have first moved any shapes on the layer to another layer. You can

then remove the layer with the “Delete Layer” command from the Layer menu.

Basic Edit Commands

Undo
Use the  Edit Undo command to reverse the last editing action, if it's possible. The
name  of  the  command  changes  depending  on  what  the  last  action  was.  The  Undo

command is disabled if there are no actions that can be undone.

You can redo the last undone action with the Redo command.

Redo
Use the Edit Redo command to redo the last undone action. The Redo command is
disabled if there are no actions that can be redone.

An action can be reverted with the Undo command.

Cut
Use the Edit Cut command to remove the currently selected shapes from the canvas
and put  them on the  clipboard.  This  command is  unavailable if  there  are  no shapes

currently selected.

Putting shapes on the clipboard replaces the contents previously stored there.

Copy
Use the  Edit Copy command to copy the currently selected shapes from the canvas
onto the clipboard. This command is unavailable if there are no shapes currently selected.

Copying shapes to the clipboard replaces the contents previously stored there.
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Paste
Use  the  Edit Paste command  to  insert  a  copy  of  the  clipboard  contents  at  the
insertion point. This command is unavailable if the clipboard is empty.

Use the Edit Paste Special command to insert a copy of the clipboard contents in the
format you specify at the insertion point. This command is unavailable if the clipboard is
empty.

Use the Edit Paste in Place command to insert a copy of the clipboard contents at
exactly the same position as the clipboard contents. This command is only available if the
clipboard contains shapes.

Delete
Use the  Edit Delete command to remove the currently  selected shapes from the
canvas. This command is unavailable if there are no shapes selected.

Ordering Shapes
The individual shapes are drawn in a stacking order,  also known as a Z-order.  The first
shape in the stack is drawn first, then the second shape in the stack is drawn, etc. Shapes
drawn later overlap the shapes already drawn. The Z-order is determined by the order in
which the shapes are added to a layer and the order of the layers. The last shape added to a
layer is on top of all the other shapes.

The user can change the Z-order using a set of  Format Order commands. The “Bring
Forward” command moves a shape one place up in the Z-order (towards the top of the draw
stack).  The  “Send  Backward”  command moves  a  shape  one  place  down  in  the  Z-order
(toward the bottom of the draw stack). A shape can be moved directly to either the top or
bottom of  the draw stack using the  “Bring to Front”  command and the “Send to Back”
command respectively.

Use the “Reverse Order” command to exchange the drawing order of two shapes.

Edit Points
Select the Format Edit Points command to move an individual vertex of a line or
polygon. A red control handle will be placed at each vertex. Position the mouse pointer

over a control handle. Click the control handle and then drag it to a new position. Release the
mouse button to place the vertex at its new coordinates. Press the shift key to move multiple
points at the same time. First select the first point and then select the last point. The selected
points will be become blue and now you can move multiple points by dragging one of the
blue points.
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To insert a vertex move the mouse pointer between two control points and hold down the
Ctrl key. Click the mouse button to place the vertex on the segment.

To remove a single vertex move the mouse pointer over a vertex and press the  Ctrl key.
Click the mouse button to delete the vertex from the shape. Press the shift  key to  delete
multiple points at the same time. First select the first point and then select the last point. The
selected points will be become blue and now you can delete multiple points by pressing the
Delete key or the D key.

Either select again the Edit Points command or press the Esc key or switch to selection
mode to exit the “Edit Points” mode.

Rotating Objects
Select the Format Rotate Object command to rotate an individual object around its
center point. A red round control handle will be placed at the bounding box corners of

the object. Position the mouse pointer over a control handle. Click the control handle and
then drag it to rotate the object. Release the mouse button to stop the rotation.

Alternatively, you can input a relative angle with the spin box that appears at the top left
corner of the canvas.

Either select again the Format Rotate Object command or press the Esc key or click
outside the object to exit the “Rotate Object” mode.

All elements can be rotated except the reference images which can only be rotated in steps of
90 degrees.

Inserting Lines
Lines  are  inserted  with  the  line  color  and  thickness  that  are  currently  set  in  the
Format Bar. You can alter this with the Format Line... command or click on the line

attribute icon.
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To insert a single straight line use the Insert Line... command. Left-click and hold
the mouse button on the canvas until the line is the appropriate length.

To insert a single straight line with an arrow tip use the  Insert Arrow line...
command. Left-click and hold the mouse button on the canvas until the arrow line is the

appropriate length.

Note: A block arrow is a possible alternative for the arrow line.  See "Inserting Block Arrows"
below.

The Insert Cross line... command allows you to insert straight horizontal or vertical
lines. Left-click and hold the mouse button on the canvas until the line is the appropriate

length.

A  line  with  multiple  vertices  can  be  added  using  the  Insert Poly Line...
command. Left-click on the canvas. Click again to place a vertex. Repeat left-clicking for

additional vertices.

To lock a vertex horizontally press the  H key. Press the  H key again to unlock. To lock a
vertex vertically press the  V key. Press the  V key again to unlock. You can switch between
horizontal and vertical locking by pressing the H key and the V key.

Double-click to finish drawing or right-click to cancel the insertion.

The Insert Free Line... command allows a poly line to be drawn without having
to place individual vertices. Left-click and hold the mouse button on the canvas to start

drawing the poly line. Release the mouse button to finish drawing.

The Insert Bezier line... command allows a two point bezier line to be drawn.
Left-click to set the start point. Left-click again to set the first control point. The third left-

click inserts the second control point. The fourth and last left-click inserts the end point.

Inserting Filled Elements
Filled shapes are inserted with the fill properties and edge properties that are currently
set in the Format Bar. You can alter the fill with the  Format Fill... command or

click on the fill attribute icon.

The Insert Polygon... command allows you to insert a polygon. Left-click on the
canvas. Click again to place a vertex. Repeat left-click for additional vertices.

To lock a vertex horizontally press the  H key. Press the  H key again to unlock. To lock a
vertex vertically press the  V key. Press the  V key again to unlock. You can switch between
horizontal and vertical locking by pressing the H key and the V key.

Double-click to finish drawing or right-click to cancel the insertion.

The Insert Rectangle... command allows you to insert a rectangle. Left-click and
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hold the mouse button on the canvas until the rectangle has the appropriate size and shape.

The  Insert Rounded Rectangle... command allows  you  to  insert  a  rectangle
with  rounded corners.  Left-click  and hold  the  mouse  button on  the  canvas  until  the

rectangle has the appropriate size and shape. Use the “Text...” command under the Format
menu to add text if needed.

The Insert Ellipse... command allows you to insert an ellipse. Left-click and hold
the mouse button on the canvas until the ellipse has the appropriate size and shape.

The  Insert Circle... command allows you to insert a circle. Left-click and hold
the mouse button on the canvas until the circle has the appropriate size.

The  Insert Free Polygon... command allows a polygon to  be drawn without
having to place individual vertices. Left-click and hold the mouse button on the canvas to

start drawing the polygon. Release the mouse button to finish drawing.

The Insert Closed Bezier... command allows a Bezier to be drawn that is filled.

Inserting Block Arrows
The  Insert Block Arrows sub-menu allows you to insert block arrows. Select the
block arrow type from the sub-menu. Left-click and hold the mouse button on the canvas

to start drawing the block arrow. Release the mouse button to finish drawing.

You can alter the arrow shape when in “Edit Points” mode. Use the “Text...” command under
the  Format menu to set an optional text string and text properties such as color and font
height.

Inserting Text
Use the  Insert Text... command to  insert  text  on the canvas.  Left-click on the
canvas where you want the text to appear. Use the “Text Attributes...” command under

the Format menu to change the text string and text properties such as color and font height.

Use the Insert Call Out... command to insert a text call-out shape. You can alter
the call-out shape when in “Edit Points” mode. Use the “Text...” command under the

Format menu to change the text string and text properties such as color and font height.

Images

Inserting an Image
An image can be  a  CGM or one of  the  other  supported image formats.  Use  one of  the
following procedures to insert an image.
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Important: Since the composition only contains a reference to the image file, you should not
delete or move the image file. An exception to this rule is if you save the composition as a
template.  Any referenced images are stored together with the template.  Use the package
facility of JustMONTAGE if you wish to move the composition between computers.

Insert Metric
This allows you to retain the metric size of the (CGM) image:

1. Select the “Image...” command from the Insert menu.

2. Select the image file from the file dialog box.

3. Click the mouse button on the canvas where you want the bottom left corner of the
image to appear.

4. Wait for the  Image Setup dialog box to appear.

5. Adjust if needed the image size and press the  OK button and wait for the image to
appear.

Insert an Image Interactively
Set the size of the image using the mouse:

1. Select the “Image...” command from the Insert menu.

2. Select the image file from the file dialog box.

3. Click and hold the mouse button on the canvas until  the image rectangle has the
appropriate width and height.

4. Release the mouse button and wait for the image to appear.
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Within the CGM Image Setup dialog box you can specify the image size in the following
ways:

• Metric (1:1). Insert the image to its metric size. This option is only available if the
image is metric.

• Box. Insert the image to the box size. This is the default if the image is abstract. The
box size is 25% of the shortest side of the canvas.

• Specified. Insert the image to the size you specify. You can set the width and height
individually if the Maintain aspect ratio option is disabled.

• Maintain aspect ratio. The aspect ratio of the image is maintained when enabled. You
may want to disable this option if you want to have exact control over the width and
height of the image. For example, if you are working with Well logs.

You can also set the image orientation. Rotations are in a counter-clockwise direction around
the bottom-left corner of the image.

Placing a Border around an Image
You can enable a border around the image by clicking on the Line/Edge properties. Select
the line type, color and width if you want a border around the image. By default there is

no border around the image.   
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Inserting a Screen Capture
You  can  make  a  screen  capture  and  insert  this  on  the  canvas  by  using  the  “Screen
capture...” command from the Insert menu. The Screen Capture dialog box will appear.

Set the capture options and press the Capture button to start the capture process. The rest of
the procedure is the same as inserting an image.

Use the crop facility to have only a part of the capture screen in your montage.

Cropping
You can make an image smaller  by trimming the  sides  of  the  image.  This  is  known as
cropping. Select first the  Format Crop command, and then position the mouse pointer
over a control handle. The cursor changes to signal that you can crop that side of the image.
Click the control handle and then drag it to a new position. Release the mouse button to crop
to the new coordinates.

Depending on the control handle selected, you can crop horizontally, vertically or both.

Use the Format Uncrop command to revert an image to its original uncropped view.

Crop By Fence
Crop by fence can be used to crop images or groups. First you have to select the group or the
image you want to crop. After selecting a group or an image draw a fence to select the area
you want to keep.
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Click on the “Crop by Fence” icon in the tool bar or use the  Format Crop by Fence
from the menu bar.  After executing the Crop by Fence command the group or image will be
updated and only the selected part will be visible.

Use the Format Uncrop to revert the image or the group to its original uncropped view.

Image Reference List
The Image References dialog box shows you a list of all the references on the canvas. Use the
“Image References...” command from the  View menu to get  the Image References dialog
box.
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In the list view you can see the State (broken or linked) of the reference. If a file path is
incorrect then the broken link icon is shown. You can also see the “Description” and the file
path “Reference”.

Double-click an entry to bring up the CGM Image Reference dialog box.

The Image Reference dialog box shows you information about the selected image file. Each
image can have a Caption/Description. This is to help you with keeping track of images. We
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recommend to keep this a short, single line of text.

The “Reference  link” shows you the path and file  name of  the  reference  image file.  An
incorrect file path is indicated by the broken link icon. Use the file browse dialog box to
repair the file path.  Note:  An incorrect  file path is indicated on the canvas by a Fuchsia
colored rectangle.

You can force an image update of the file by pressing the Refresh button.

Press the OK button to set the image reference properties. Press Cancel to dismiss the dialog
box.

Rotating an Image
Use  the  Format Image Orientation... command  to  rotate  the  image.  This
command is only enabled if a single image shape is selected on the canvas.

The  Image  Orientation  dialog  box  allows  you  to  change  the  (CGM)  image  orientation.
Rotations are in a counter-clockwise direction around the middle of the image. Make your
selection and press OK to change the image orientation.

Resizing an Image
Use  the  Format Image Size... command  to  (re)set  the  size  of  the  image.  This
command is only enabled if a single image shape is selected on the canvas.
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The Image Size dialog box allows you to change the  size of  the (CGM) image.  You can
specify the image size in the following ways:

• Metric (1:1). Reset the image to its metric size. This option is only available if the
image is metric.

• Box. Set the image to the box size. This is the default if the image is abstract. The box
size is 25% of the shortest side of the canvas.

• Specified. Set the image to the size you specify. You can set the width and height
individually if the Maintain aspect ratio option is disabled.

• Maintain aspect ratio.  The  aspect  ratio  of  the  image  is  maintained  when
enabled. You may want to disable this option if you want to have exact control over
the width and height of the image. For example, if you are working with Well logs.

Make your selection and press OK to set the image size.
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Editing an Image
Use the Format Image Edit... to edit an image presuming that you have a JustEDIT
license. JustMONTAGE will start JustEDIT with the image. Note that no changes will appear
in JustMONTAGE as long as JustEDIT is running.

Properties

The Format Bar
The Format bar gives you quick access to the most common text, line/edge and fill properties.

You can use the Format bar in two different ways.

• To have the properties set for the element you are inserting. For example a text shape
will use the selected font, point size, etc.

• To modify the properties of one or more shapes you have selected on the canvas.

Line and Edge Properties
Use the Format Line... command to set the line or edge properties. The Line/Edge
Properties dialog box will appear.
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Line / Edge Properties

Line Color Select the line/edge color from the combo box.

Line Type Set the line/edge from the combo box. Select No Line/Edge to disable
the drawing of an edge.

Line Width Select the line/edge width from the combo box.

Start/End Arrow For lines you can also select a start arrow and/or end arrow. Select the 
arrow from the list.

Make your selection and press OK to change the line/edge properties. Press Cancel to abort
the line/edge properties changes.

Fill Properties
Use the  Format Fill... command to  set  the  fill  properties.  Depending on what
shape(s) you have selected you will see either:

• The Image Fill dialog box if you have selected a single (CGM) image on the canvas.

• The Fill Properties dialog box in all other cases.
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The Image Fill dialog box

The “Background Fill Type” determines how the background of the image is treated. Select
one of the following:

• CGM to  fill  the background of  the image with the background color  of  the CGM.
(Usually white.)

• Transparent to disable the background of the CGM. This causes any shapes below
the image to show through the blank image areas.

• Color allows you to set the background of the image to a specific color. Select the
background color from the combo box.

The “Image Opacity” allows you to partially show through what’s beneath the image. Note
that 0% opacity means completely transparent and the image will be invisible.
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The Fill Properties Dialog Box

The Fill Properties dialog box allows you to set the style with which the shape is to be filled.

The style can be  Empty if you do not want the shape to be filled. You can select a  Solid
background in which case you can set the fill color from the Background combo box. The
“Transparency” option controls how transparent the solid fill color will be.

Selecting Hatch as style allows you to set one of the hatch types with a specific hatch color.

Selecting Pattern as style allows you to select one of the fill patterns. The Background and
Pattern  control  the  colors  of  the  pattern.  You  can  make  a  pattern  semi  transparent  by
enabling  “Transparent  background”  and  select  the  “Background”  color  that  should  be
treated as transparent.

Selecting Gradient as style allows you to select a gradient fill. The gradient fill can be either
horizontal from top to bottom or vertically from left to right.
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Rich text boxes, call outs and  block arrows can have a shadow and/or round corners. The
contents of the Shadow and Corner tab will be enabled if the selected element support these
options.

Make your selection and press OK to change the fill properties. Press Cancel to abort the fill
properties changes.

Text Properties
Use the  Format Text... command to set  the text  properties.  The Text Properties
dialog box will appear.

130

Illustration 86: Example of shadow and round corners.



Justcroft International

Text Properties

Text Enter the text you want to have in the text box. You can have 
multiple lines of text by pressing the Enter key.

Font name Select the font name from the combo box.

Font Size Select a point size from the combo box or enter a point size 
directly.

Font Color Select the text color from the combo box. You can also change 
the color of a partially selected text.

Style Select Bold to use the bold variant of the font. Select Italic 
(oblique) to use the italic variant of the font.

Select Underscore to underscore the text. Select Strike-through 
to have a strike-through text.

Select Superscript to have superscript characters. Select 
subscript to have subscript characters.
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Text Properties

Bullets You can switch between lists text with or without bullets.

Horizontal Alignment Horizontally align text either left, center or right within the text 
box.

Vertical Alignment Vertically align text either top, middle or bottom within the text
box.

It's possible to use different font sizes in one text element. The behavior of changing the font
size is changed: first select that part of the text in which you want to change the font size and
then change it. 

Make your selection and press OK to change the text properties. Press Cancel to abort the
text properties changes.
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JustEDIT
JustEDIT is a CGM vector editing tool. However, you can also edit other file types as CGMs
if you have the appropriate Input File Converter. CalComp 906, CalComp 907, CalComp 925,
MicroStation DGN V74, EMF, HP-GL, HP-GL/2 or PDF file types are vector editable. Bitmap
based file types are only limited editable.

You can start  JustEDIT in the  JustIMAGE 5.4 User Interface by selecting the “JustEDIT...”
command from the  Tools menu or  by selecting the  JustEDIT icon from your Windows
Desktop.

You can use the “Open...” command from the File menu within JustEDIT to open a file. You
will be prompted for the file name. Select the file you want to edit and click Open. You can
also  open  a  file  by  dragging  the  file  to  JustEDIT icon  on  the  Windows Desktop  or  by
dragging it to the JustEDITmain interface.

JustEDIT uses file locks to prevent multiple instances of the JustEDIT application to edit the
same file at the same time. This does not prevent other applications from editing the file.

If  the  CGM Optimiser is enabled and a license has been purchased for this module then
JustEDIT will, by default, first optimize the CGM for editing.

JustEDIT will try to match the font names used in the CGM with the available scalable fonts.
If a font was not recognized you will be prompted for a font substitute.

Select from the font combo box the appropriate font. Later changes to the mapping can be
made through the Font List dialog box.

Introduction to the JustEDIT User Interface
Within the main window of the JustEDIT User Interface is a menu bar which provides you
quick access to all the commands of the JustEDIT Graphical User Interface. However, most

4 DGN V7 support requires a special separately licensed module.
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common commands can  still  be  quickly  accessed through the  various  tool  bars  such  as
File bar, Edit bar, etc.

To show or hide the individual tool bars go to either the  View menu or right-click on the
toolbar area and toggle the individual tool bars on or off as required.

The drawing area is the window area of JustEDIT on which the various objects can be placed.
The  white  area  within  the  drawing  area  is  called  the  canvas.  Note  that  objects  can  be
positioned outside the canvas. These elements will be invisible when saving the CGM.

Control handles are small boxes that appear on an object when you select it. For objects such
as lines or poly lines, the control handles are placed on each vertex of the object.

Not all objects of a CGM file can be edited. Currently supported objects are straight lines,
poly lines, rectangles, circles, ellipses, polygons, arcs, Cell Arrays/Tiles and text. Any CGM
element that cannot be edited is drawn as a bitmap on the canvas.

The  JustEDIT User Interface will appear differently depending on the OS and Window
manager used.  User  preferences of  JustEDIT can be  controlled by selecting the  Edit

Preferences... command from the menu bar.
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Object Selection
By default,  JustEDIT starts in selection mode. If you are not in selection mode, you can
switch to it by deselecting the “Pan Mode” from the View menu or deselect the pan tool

button.

To select a single CGM element click on it whilst selection mode is activated. To select
multiple objects, hold the Ctrl key and then click each of the objects you want to include

in the selection.

An alternative for holding the  Ctrl key is to use the  Format Select Multiple
Shapes mode.

Another way to make a selection is to use the fence mode. Select  Edit Fence Mode
from the menu bar. Now drag the rectangle fence over the canvas. Next use the  Edit

Select All command to select all the editable objects within the fence.

Use the Edit Select All command when a fence has not been set, to select all the
editable objects on the canvas.

An advanced form of selection is possible using the “Find” command. See the text below for
more information about this kind of selection.

Moving Objects
When  JustEDIT is in selection mode, selected objects can be moved by clicking them and
dragging the mouse.

Nudging
You can do slight moves of objects with the nudge operations. Select the objects you want to
nudge. Either use one of the nudge directions or uses the cursor keys.

Note: The nudge amount is, by default,  2 pixels, but this can be changed from the Align
toolbar and under Edit Preferences...Advanced.

Aligning Elements
You can line up objects using the alignment operations. First select the objects you want to
align. The last selected element becomes automatically the control element. If needed use the
Ctrl key to select which is the control element. Next select one of the alignment actions. The
alignment is handled based on the control element.
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Sizing Objects
If an object can be resized, the pointer turns into a directional arrow when
you  place  the  pointer  over  one  of  the  control  handles  on  the  object.
Depending  on  the  object  you  select,  you  can  either  scale  the  object
horizontally, vertically, or both.

JustEDIT allows you to resize both the height and width of a group of
selected objects.

Color Selection
The color  selection combo box allows colors  to  be  selected  from a
predefined  list  of  colors.  Note  that  the  predefined  list  of  colors  is
controlled  by  setting  the  color  bar from  the  Colors  tab  under  the
preference  settings  of  JustEDIT.  See  also  the  “JustIMAGE  5.4
Reference Manual, Configuration, Custom Colors” section.

Selecting the “…” entry will bring up the Select color dialog box. The Select color dialog box
allows a color to be selected in a number of ways.

Either select one of the “Basic colors” or select a custom color using the mouse from the
palette. An alternative is to enter the values as Hue, Saturation and Value (HSV) or as Red,
Green, Blue (RGB) value. Click the “Add to Custom Colors” button to use the same custom
color another time.
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Another method is to pick a screen color. Select the pick screen color button. The mouse will
change into a cross. You can now select a color by going over your screen to sample a color.
Press the mouse button to make a selection.

Make the selection and press OK to set the color. Press Cancel to abort the color change.

Zooming
There  are  several  ways  to  zoom  in  on  the  canvas.  Zooming  works  the  same  as  in  the
JustIMAGE 5.4 Viewer.

Scaled Zoom
You can zoom in steps of 25%. Either select the “Scale +25%” command from the View
Zoom menu or click on the zoom in button on the toolbar.

You can zoom out in steps of 25%. Either select the “Scale -25%” command from the
View Zoom menu or click on the zoom out button on the toolbar.

You can also zoom in and zoom out by using the mouse wheel while holding the Ctrl key
pressed down.

There are also three fixed scale zoom possibilities:

• Zoom to 50%. Scale the canvas to half its metric size.
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• Zoom to 100%. Scale the canvas to its metric size.

• Zoom to 200%. Scale the canvas to double its size.

Rectangle Zoom
The rectangle zoom allows you to zoom in on a part of the canvas by dragging a rect-
angle with the mouse. Either select the “Zoom Rectangle...” command from the  View

Zoom menu or click on the rectangle zoom button on the toolbar. The cursor will change
into the Zoom cursor. Go with the mouse to the part of the picture you want to zoom in on,
and click and hold the left mouse button. Drag the mouse to the desired size of the rectangle
and let go of the mouse button.

Page Zoom
To fit the canvas to the main window, select the “Whole Page” command from the View
Zoom menu. Alternatively, click on the “Whole Page” zoom button on the toolbar.

The page width zoom allows you to match the width of the canvas to the width of the main
window. Select the “Page Width” command  from the View Zoom menu.

The page height zoom allows you to match the height of the canvas to the height of the main
window. Select the “Page Height” command  from the View Zoom menu.

Shortest Side
Use this command to fit the shortest side of the canvas to the size of the main window.
This is useful when viewing long images such as Well Logs. Select the “Shortest Side”

command from the View Zoom menu.

Full Screen
Use the  View Full Screen command to expand the main window to the entire
screen. This will  also hide the menu bar and the status bar.  Use the shortcut key to

switch back to the normal mode.

Full Pointer Cursor
Use the  View Full Pointer Cursor command to have horizontal and vertical guide
lines that cross each other where the cursor is. You may want to use this together with the
rulers to have a more precise control over where an element is positioned.
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Panning
You can pan on the canvas when you are zoomed in. Use the scroll bars around the main
window to pan. You can also use you mouse scroll wheel to pan vertically.

You can also switch to the mouse pan mode. Enable the mouse pan mode by either
selecting “Pan Mode” command from the View menu or click on the pan hand icon on

the toolbar.  You can now pan by clicking and holding the mouse button pressed on the
canvas. Move the mouse to pan.

Background Image
Use the  View Background Image command to toggle the background which depicts
objects that cannot be altered. To make the editor more responsive, disable the background.
This is especially noticeable on X server systems or remote desktops. A check mark appears
next to the menu item when the background image is enabled.

Symbols
The  symbols  toolbox  can  be  used  to  put  TrueType
font  symbols  on your  canvas.  The  symbols  toolbox
can  have  one  or  more  groups  as  in  Microsoft
Outlook®.

The  View Symbols sub-menu gives access to the
symbols toolbox.  Use the “Symbols Bar” command to
display and hide the symbols toolbox. A check mark
appears  next  to  the  menu  item  when  the  symbols
toolbox is displayed.

Initially  the  symbols  toolbox  contains  a  set  of  Well
symbols (Oil Well). To setup a symbol list,  select the
“Add symbol font…” command or right-click on the
symbols toolbox and select the “Add symbol font…”
command. In the Add Symbol Font dialog box select
the symbol font file and set an appropriate title.

To add more then one group, repeat the previous step. To remove a group, right-click a
group and select the “Remove symbol font” command.

If you have loaded a CGM, you can drag the symbol you want to use on to the canvas. A
symbol behaves like a text element. Alter the font size to make the symbol bigger or smaller.
The font color determines the color of the symbol.

You can set a symbol as one of your favorites by right-click on the symbol and select the
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“Add to favorites” command. The symbol will now be added to the Favorites group.

Grouping Objects
You can temporarily group objects together to form composites. Select the objects you
want to group together and then click the Group button. Grouped objects act like a single

graphical object.  Note that you will lose the grouping once you have closed the file.

To  ungroup,  select  the  composite  objects  you  want  to  ungroup  and  then  click  the
Ungroup button.

Saving your Changes
Use the “Save” command from the File menu to save the CGM to its current name and
directory.

Use the “Save As...” command from the File menu to save the CGM under a different
name or in a different directory.  JustEDIT will display the Save As dialog box so the

CGM file can be named.

Important: JustEDIT will, by default, save the CGM with the font name mapping used when
opening the file. Use the Font List dialog box settings to prevent this. See the Font List dialog
box description below for more information.

Export
A CGM can be exported to a BMP, GIF, JPEG, PBM, PGM, PPM, PNG, TIFF, PDF or SVG
file. Select the “Export...” command from the  File menu. The Export dialog box will

appear.

Use the fence mode to if you want to export only a part of the CGM.

Export to PowerPoint
A CGM can be exported to a PowerPoint 2007 file on Windows. Select the “Export to
PowerPoint...” command from the  File menu. The Export to PowerPoint dialog box

will appear. You can either create a PowerPoint file or add a PowerPoint slide to an existing
PowerPoint file.

Use the fence mode if you want to export only a part of the CGM.

Printing
A CGM can be printed by selecting the “Print...” command from the  File menu. The
Print dialog box will appear.
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Use the fence mode if you want to print only a part of the CGM.

Working With Layers
A layer is a transparent level object on which shapes are placed. The CGM you load into edit
might have one or more layers. Layers can help you work efficiently. You can use layers to
organize similar shapes together. For example, you might use one layer for text and another
layer for images. By default, when you place a shape on the canvas, it is placed on the active
layer.

When the CGM does not have layers, all elements are placed on one layer (Layer 1) which is
also the active layer. You can than add more layers. You can control the visibility of the layer
so that you can make separate prints or exports with or without the shapes of a specific layer.

Adding a New Layer
Select “Add Layer...” from the Layer menu or click on the icon in the layer toolbar. You

will be prompted for the layer name.

Select if the layer is a top layer or a sub layer. The layer name has to be unique within the
composition.

Make the layer current by highlighting the layer from the layer toolbox. Any shapes you now
insert will be added to the current (highlighted) layer.

You can move shapes between layers by selecting them, set the current layer and then use
the  “Move  selection  to  current  layer”  command  from  the  Layer menu to  move  them.
Alternatively, use copy & paste to move shapes between layers.

Changing the Layer
You can rename a layer with the “Rename Layer...” command from the Layer menu. You

will be prompted for the new layer name.
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Layers are drawn from bottom to top in the layer stack. You can move layers up and down
using the arrows in the layer toolbox or alternatively use the “Raise Layer” and “Lower
Layer” commands from the Layer menu.

Use the “eye” icon in the layer toolbox to toggle the visibility of a layer and possible sub
layers. Invisible layers will not be visible when exported or printed.

Removing a Layer
Make sure that you have first moved any shapes on the layer to another layer. You can

then remove the layer with the “Delete Layer” command from the Layer menu.

Basic Edit Commands

Undo
Use the  Edit Undo command to reverse the last editing action, if it's possible. The
name  of  the  command  changes  depending  on  what  the  last  action  was.  The  Undo

command is disabled if there are no actions that can be undone.

You can redo the last undone action with the Redo command.

Redo
Use the Edit Redo command to redo the last undone action. The Redo command is
disabled if there are no actions that can be redone.

An action can be reverted with the Undo command.

Cut
Use the Edit Cut command to remove the currently selected objects from the canvas
and put  them on the  clipboard.  This  command is  unavailable if  there  are  no objects

currently selected.

Putting objects on the clipboard replaces the contents previously stored there. The clipboard
is cleared if you close the currently loaded CGM and select another CGM.

Copy
Use the  Edit Copy command to copy the currently selected objects from the canvas
onto the clipboard. This command is unavailable if there are no objects currently selected.

Copying objects to the clipboard replaces the contents previously stored there.
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Paste
Use  the  Edit Paste command  to  insert  a  copy  of  the  clipboard  contents  at  the
insertion point. This command is unavailable if the clipboard is empty.

Note: This command also allows you to paste bitmap images from the clipboard.

Use the Edit Paste in Place command to insert a copy of the clipboard contents at
exactly the same position as the clipboard contents. This command is only available if the
clipboard contains shapes of the current canvas.

Delete
Use the  Edit Delete command to remove the currently  selected objects  from the
canvas. This command is unavailable if there are no objects selected.

Ordering Objects
The individual objects are drawn in a stacking order, also known as a Z-order. The first CGM
element in the stack is drawn first, then the second CGM element in the stack is drawn, etc.
objects drawn later overlap the objects already drawn. The Z-order is determined by the
order in which the objects are added to the canvas. The last element added is on top of all the
other elements.

The user can change the Z-order using a set of  Format Order commands. The “Bring
Forward” command moves a CGM element one place up in the Z-order (towards the top of
the draw stack). The “Send Backward” command moves a CGM element one place down in
the Z-order (toward the bottom of the draw stack). A CGM element can be moved directly to
either the top or bottom of the draw stack using the “Bring to Front” command and the
“Send to Back” command respectively.

Edit Points
Select the Format Edit Points command to move an individual vertex of a line or
polygon. A red control handle will be placed at each vertex. Position the mouse pointer

over a control handle. Click the control handle and then drag it to a new position. Release the
mouse button to place the vertex at its new coordinates. Use the Shift key to move multiple
points at the same time. First select the first point and then select the last point. The selected
points will be become blue and now you can move multiple points by dragging one of the
blue points.

To insert a vertex move the mouse pointer between two control points and hold down the
Ctrl key. Click the mouse button to place the vertex on the segment.

To remove a single vertex move the mouse pointer over a vertex and press the  Ctrl key.
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Click the mouse button to delete the vertex from the shape. Press the shift  key to  delete
multiple points at the same time. First select the first point and then select the last point. The
selected points will be become blue and now you can delete multiple points by pressing the
Delete key or the D key.

You can use also this command to change a call-out and change the arrow shape of block
arrows.

Either select again the Edit Points command or press the Esc key or switch to selection
mode to exit the “Edit Points” mode.

Rotating Objects
Select the Format Rotate Object command to rotate an individual object around its
center point. A red round control handle will be placed at the bounding box corners of

the object. Position the mouse pointer over a control handle. Click the control handle and
then drag it to rotate the object. Release the mouse button to stop the rotation.

Alternatively, you can input a relative angle with the spin box that appears at the top left
corner of the canvas.

Either select again the Format Rotate Object command or press the Esc key or click
outside the object to exit the “Rotate Object” mode.

Inserting Lines
Lines are inserted with a default line color and thickness. You can alter this with the
Format Line Attributes... command.

To insert a single straight line use the Insert Line... command. Left-click and hold
the mouse button on the canvas until the line is at the appropriate length.

To insert a single straight line with an arrow tip use the  Insert Arrow line...
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command. Left-click and hold the mouse button on the canvas until the arrow line is the
appropriate length.

Note: A block arrow is a possible alternative for the arrow line. See “Inserting Block Arrows”
below.

The Insert Cross line... command allows you to insert straight horizontal or vertical
lines.  Left-click  and  hold  the  mouse  button  on  the  canvas  until  the  line  is  at  the

appropriate length.

A  line  with  multiple  vertices  can  be  added  using  the  Insert Poly Line...
command. Left-click on the canvas. Click again to place a vertex. Repeat left-clicking for

additional vertices.

To lock a vertex horizontally press the  H key. Press the  H key again to unlock. To lock a
vertex vertically press the  V key. Press the  V key again to unlock. You can switch between
horizontal and vertical locking by pressing the H key and the V key.

Double-click to finish drawing or right-click to cancel the insertion.

The Insert Free Line... command allows a poly line to be drawn without having
to place individual vertices. Left-click and hold the mouse button on the canvas to start

drawing the poly line. Release the mouse button to finish drawing.

The Insert Bezier line... command allows a two point Bezier line to be drawn.
Left-click to set the start point. Left-click again to set the first control point. The third left-

click inserts the second control point. The fourth and last left-click inserts the end point.

Inserting Filled Elements
Filled objects are inserted with a default color and without an edge. You can alter the fill
with the Format Fill Attributes... command.

The Insert Polygon... command allows you to insert a polygon. Left-click on the
canvas. Click again to to place a vertex. Repeat left-click for additional vertices.

To lock a vertex horizontally press the  H key. Press the  H key again to unlock. To lock a
vertex vertically press the  V key. Press the  V key again to unlock. You can switch between
horizontal and vertical locking by pressing the H key and the V key.

Double-click to finish drawing or right-click to cancel the insertion.

The Insert Rectangle... command allows you to insert a rectangle. Left-click and
hold the mouse button on the canvas until the rectangle has the appropriate size and

shape.

The Insert Ellipse... command allows you to insert an ellipse. Left-click and hold
the mouse button on the canvas until the ellipse has the appropriate size and shape.
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The Insert Circle... command allows you to insert a circle. Left-click and hold the
mouse button on the canvas until the circle has the appropriate size.

The  Insert Free Polygon... command allows a polygon to  be drawn without
having to place individual vertices. Left-click and hold the mouse button on the canvas to

start drawing the poly line. Release the mouse button to finish drawing.

Inserting Block Arrows
The  Insert Block Arrows sub-menu allows you to insert block arrows. Select the
block arrow type from the sub-menu. Left-click and hold the mouse button on the canvas

to start drawing the block arrow. Release the mouse button to finish drawing.

You can alter  the arrow shape when in  “Edit  Points” mode.  Use the “Text Attributes...”
command under the Format menu to set an optional text string and text properties such as
color and font height.

Inserting Text
Use the  Insert Text... command to insert a text block. Left-click on the canvas
where  you want  the  text  to  appear.  Use  the  “Text Attributes...”  command under  the

Format menu to change the text string and text attributes such as color and font height.

Use the  Insert Call Out... command to insert a text call-out. You can alter the
call-out shape when in “Edit Points” mode. Use the “Text Attributes...” command under

the Format menu to change the text string and text properties such as color and font height.

Inserting a Bitmap
You can insert either a BMP, GIF, JPEG, PNG or WebP bitmap image on the canvas.

Insert a bitmap using the mouse:

1. Select the “Image...” command from the Insert menu.

2. Select the image file from the file dialog box.

3. Click and hold the mouse button on the canvas until  the image rectangle has the
appropriate width and height.

4. Release the mouse button and wait for the image to appear.
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Attributes

Fill Attributes
Use the  Format Fill Attributes... command to change the CGM fill attributes
of one or more selected filled objects. Depending on what you have selected you will see

either:

• The Image Fill Properties dialog box if you have selected an image on the canvas.

• The Fill Properties dialog box in all other cases.

The “Image Opacity” allows you to partially show through what’s beneath the image. Note
that 0% opacity means completely transparent and the image will be invisible.
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Solid Fill: Select the fill color and optionally set the transparency of the color.

Hollow Fill: This is a special style which only has an effect if the edge is turned off. Only the
outline of the object is drawn with the selected color.

Empty Fill: Don't fill the object.

Hatch  Fill:  Select  the  type  of  hatch  and  the  color  of  the  hatch.  Additionally  set  the
background mode to either “Transparent” or to “Opaque”.

Pattern Fill: You can either select a pattern or add a new pattern fill. Select from the “Pattern”
combo box Add.... You can now select a pattern from the pattern selection dialog box. It is
also  possible  to  select  a  custom pattern.  The custom pattern file must  be a  PNG with a
maximum size of 64×64 pixels.

Gradient Fill: Select the gradient to be either horizontally from top to bottom or vertically
from left to right. Note: This is a CGM fill type that is in most cases not supported by other
third-party applications.
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Rich text  boxes,  call  outs  and block arrows can have a shadow and round corners.  The
contents of the Shadow and Corner tab will be enabled if the selected element supports these
attributes. 

Line Attributes
Use the Format Line Attributes... command to change the line attributes of one
or more selected line elements.

Enable the “Apply to all elements on the layer” if you want to change the line attributes
except arrows of all line elements on the layer. The “Apply to all elements on the layer and
sub layers” works the same, except that will also change any lines on sub layers as well.
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Text Attributes
Use the Format Text Attributes... command to change the CGM text attributes of
one or more selected CGM text elements. The actual text string can also be altered here. Use
the check boxes to select which attributes should be changed. This can be useful if you have
multiple text elements selected.
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Illustration 97: The Line Attributes dialog box of
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This allows you to enter rich text with various text styles applied to individual parts of the
text including different colors. You can also create a bullet list if needed.
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Illustration 98: The Text Attributes dialog box of JustEDIT.

Illustration 99: The Rich Text Attributes dialog box of
JustEDIT.
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Finding Elements
Use the Edit Find... command to make selections based on the attributes of a CGM
element. There are three possible categories of objects: Line, Text and Filled. Within each

category you can select different attributes you want to search for. Deselect any attributes by
deselecting the check box.

You can search by example. Select one of the specific objects to find and then select the Edit
Find... command. The Find dialog box will come up with the attribute values already
set. Deselect possible attributes that are not required and click OK.

Line Attributes

Color The color of the line.

Transparency The amount of transparency applied to the line.  Note that 0% means 
completely opaque.

Width The thickness of the line. Units are based on your preference settings.

Style One of the five possible line styles.

Background This is only applicable if one of the dashed line styles is selected. 
Transparent means that the gaps between the dash segments is not 
filled. Otherwise the gaps are filled with a particular color.

Length Length of a horizontal or vertical line with 2 points. This can be used 
to select a number of lines with the same size. 

Text Attributes

Font The font name and possible style: Normal, Bold, Italic or Bold + Italic.

Color The text color.

Transparency The amount of transparency applied to the text.  Note that 0% means 
completely opaque.

Expansion The font stretch. Values less then 1.0 means that individual glyphs are 
more narrow than normal. Values higher then 1.0 means that individual 
glyphs are wider than normal.

Height The text height. Note: text heights in CGM are not directly related to the 
usual point sizes.
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Text Attributes

Rotation This describes the base line angle counter-clockwise to the horizontal.

Path The text path. Right is the common western text direction where 
characters are oriented from left to right. Left means characters are 
oriented from right to left. Up means from bottom to top and Down 
means from top to bottom. All these orientations are based on the text 
start point which is indicated by a small green dot when a text element is 
selected.

Background CGM text has an implicit rectangle around the whole text string. When set
to opaque this rectangle is filled with the specified color.

Text Search case sensitive for a particular string. Note that searching for text is, 
by default, disabled. The wild-card characters *, ?  maybe used for 
searching.
If you want to search for a range of numbers you can use /int [min max]. 
For example /int [200 2000] to find all number between 200 and 2000.

Text case 
sensitive

Allow case sensitive or case in-sensitive text search.

Fill Attributes

Style The fill style.

Color The fill color. This is not applicable when the empty style or 
pattern style is selected.

Transparency The amount of transparency applied to the fill and edge. Note 
that 0% means completely opaque or solid fill.

Hatch Applicable if the fill style is hatch. This is one of the possible 
hatch styles.

Pattern Applicable if the fill style is pattern.

Hatch/Edge background The hatch or dashed edge gaps are either not filled or filled with a
specific color.

Pattern transparency Patterns can be color keyed. That is, a specific color within the 
pattern is designated as an indicator that the pattern cell should 
not be filled and whatever is under the pattern cell is shown.
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Fill Attributes

Edge Filled objects can have an edge. That is, a border around the filled 
element.

Edge color The color of the edge if the edge is enabled.

Edge style The style of the edge if the edge is enabled.

Edge width The width of the edge if the edge is enabled.

Replacing Elements
The  Edit Replace... command  allows  the  attributes  of  a  CGM  element  to  be
changed. Which CGM element is replaced works in the same way as the Find command.

By deselecting the attribute check boxes all  possible  applicable attributes or  a  sub-set  of
attributes can be replaced.

The example above illustrates how to change a fill style to solid red with a 30% transparency.

Tip: To globally change a specific font into a different font then it is much easier and faster to
use the “Font List...” command under the Format menu.

Special Editing Commands

Smooth
Use the Insert Smooth command to round angled line segments.
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Closing a Line
Select one or more CGM line elements and use the  Insert Close Line command to
close up line segments.

Joining Disjoint Lines
Select two or more CGM line elements and use the Insert Close Gaps command to join
disjoint lines such as fault lines together. This command works best when lines are laid out
in either a horizontal or vertical direction.
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Illustration 101: The effect of the Smooth command.

Illustration 102: Closing a line.
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Cutting a Line
The  Insert Cut Line command allows you to discard part of a line. The cut can be
made anywhere on the line, not just on a vertex. First left-click at the point where the cut is to
be made, then click the part of the line to be thrown away.

The  Insert Split Line command  is  like  the  “Cut Line”  command  but  without
removing the line segment, effectively cutting the line into two separate lines. Left-click the
point where the split is to be made.
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Illustration 104: Cutting a line and discard a line part.

Illustration 103: Joining Disjoint Lines.
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Fill
The Insert Fill command can be used for two different purposes. You can turn a single
selected poly line into a polygon with this command.

Selecting two roughly parallel lines will cause the area between the two lines to be filled with
a semi transparent polygon of 50% yellow.

Selecting three or more lines that form an enclosed area will cause this area to be filled with a
semi transparent polygon.
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Illustration 105: Turning a poly line into a polygon using the Fill command.

Illustration 106: Automatic fill between two fault lines using the Fill 
command.
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To Unconformity
The  Insert To Unconformity command converts any line into a sinusoidal wave. The
Unconformity  dialog  box  will  appear  where  you  can  enter  the  amplitude  and  repeat
distance.
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Illustration 108: The To Unconformity Line 
dialog box

Illustration 107: Automatic fill between three fault lines using the Fill 
command.
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Add Text to Line
The Insert To Add text to Line command allows text to be added to the selected
line. The CGM text dialog will appear and after pressing OK the text will be added to the
line. The text is a separate element if you want to move the line and keep the text along the
line you have to group the text and line first.

Fill with Symbols
The  Format Fill with Symbols... command will allow you to fill a polygon with
one or two symbols.

Either drag a symbol to the dialog box or select the appropriate symbol font and enter one or
two symbols to be used for filling.  You can specify the symbol color, it's  height and the
relative distance between symbols.

The Randomness factor determines how random the symbols will be distributed within the
fill. A factor of 0 means that all symbols will be evenly distributed. A factor greater then 1.0
will cause symbols to overlap.
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Illustration 109: A line converted to an unconformity line.

Illustration 110: Example of text added to a line in JustEDIT.
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Symbols can be either orientated based on the edges of the polygon or uniformly rotated
with a specific angle.

Fill with Images
The  Format Fill with Images... command will allow you to fill a polygon with
small PNG image as a symbol.

Select the appropriate  PNG to be used for filling. Note that the PNG should not be bigger
than 128x128 pixels. You can specify the height and the relative distance between symbols.
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Illustration 112: A polygon filled with symbols.

Illustration 111: The Fill with Symbols dialog box.
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The Randomness factor determines how random the symbols will be distributed within the
fill. A factor of 0 means that all symbols will be evenly distributed. A factor greater then 1.0
will cause symbols to overlap.

Symbols can be either orientated based on the edges of the polygon or uniformly rotated
with a specific angle.

Editing the CGM Font List
The Format Font List... command will bring up the Font List dialog box. The CGM
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Illustration 114: A polygon filled with images.

Illustration 113: The Fill with Images dialog box.
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font list of the file can be manipulated in this dialog.

The “CGM Font name” is the name of a font as it was in the file when opened in JustEDIT.
The “System Font name - style” is the font and style used to show the font in JustEDIT. When
saving you can select which font name will be written in the CGM. This is, by default, the
name of the font used in JustEDIT. To retain the original name select the check box in front of
the CGM font name.

To change the font used by JustEDIT, double-click the Edit font name. The Font Map dialog
box will appear.

Here the JustEDIT font and / or the style used can be altered. Click on OK to make the change.
Click on Cancel to dismiss the dialog box without making any changes.

Custom Line Type
The Format Custom Line Type… command will bring up the Custom Line Type dialog
box.
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Illustration 115: The Font List dialog box of JustEDIT.

Illustration 116: The Font Map dialog box of
JustEDIT.
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One or more custom line types can be created, by default the menu will add a new custom
line type. An existing custom line can be changed by selecting the custom line in the combo-
box. The number of pairs and the dash and gap values can be changed.  A dash value of 0
represents a dot.

The newly created line type can be selected in the Line Attributes dialog for the line primitive
and in the Fill Attributes dialog for the edge of the fill primitive.

Color Change
The Format Color... command will bring up the Color dialog box.
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Illustration 117: The Custom Line Type dialog box.
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You can invert black and white colors in the selected element. Use “All elements” if you want
to globally change black and white.
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Illustration 118: The Colors dialog box of
JustEDIT.
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How to Retrieve a file
A file can be retrieved using the  JustSEARCH module. This requires that the  JustSEARCH
Server is running and can be accessed from your computer.

It could be that the JustSEARCH Server is temporarily deactivated by a manager. In this case
you will not be able to retrieve a file.

This can happen if the system has been disabled for users because of maintenance. You can
try to retrieve if you know that the system will become available very soon. Otherwise you
can wait several minutes and try again.
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Illustration 119: JustSEARCH Server deactivated 
warning when retrieving.

Illustration 120: The Retrieve dialog box.
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Viewer: Montage composition files cannot be retrieved. All the other default File Types can
be retrieved.

JustSEARCH manager: The Retrieve functionality is for testing purposes only. No actual
file will be retrieved. You can always access the Retrieve dialog box regardless whether
the JustSEARCH Server is active or not.

JustEDIT: JustMONTAGE composition  files  cannot  be  retrieved.  All  the  other  default
File Types can be retrieved. Note that the File Type query filter is by default set to CGM.
You must either set it to another File Type or disable the query filter if this is not what you
intended.

JustMONTAGE: Only  JustMONTAGE composition files can be retrieved. Note that the
File Type query filter is already set to help you with this.

The Retrieve dialog box is roughly divided into two sections. The top half allows you to set
one or more queries  while  the bottom half  shows the result  of  the query.  Note that,  by
default, only the basic queries are shown. Check the Advanced check box to bring up the
advanced table with attributes.

Set  the check box before the query to select the query.  You must set at least one query.
Queries  are  inner  joins  which  means  that  if  you have multiple  queries  everything  must
match the individual query.

The query value you can enter depends on the type of query. Any text field must match the
complete text string. You can use wildcards. Use '*' to match zero or more characters while '?'
will  match  a  single  character.  For  example  if  you  enter  ben*.cgm, this  will  match
benseis.cgm.

Dates can be entered either as an exact date, any date before the given date, any date after the
given date or between two dates. Note that dates are stored in the system as UTC date/times
to prevent ambivalence.
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Justcroft International

Original user and Last user are ids that are stored by the system. You can use wildcards for
these as well.

Tags are comma-separated values that were entered when a file was stored.

Advanced  attribute  queries  can  be  used  by  selecting  the  check  box  before  the  name.
Depending on the attribute type you can set an operator. The query value should be entered
in the first  Value column by double-clicking the  value cell.  The second Value column is
usually disabled except when a range selection is made for numbers or a date.

Select With Preview if you want a small preview image in the result of the search query.
Having a preview does slow down the query. Press Find to start the query. This can take a
second to a couple of seconds depending on the complexity of the query and whether you
had selected With Preview.

Select the file you want to load and press Retrieve to load it in the main interface. Note that
the dialog box will stay open until you select Close5.

5 Except in the JustSEARCH manager. The dialog box will close in this interface.
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Illustration 122: An example query result when doing a retrieve.
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How to Store a file
A file  can be stored using the  JustSEARCH module.  This  requires  that  the  JustSEARCH
Server is running and can be accessed from your computer.

It could be that the JustSEARCH Server is temporarily deactivated by a manager. In this case
you will not be able to store a file.

This can happen if the system has been disabled for users because of maintenance. You can
try to store if you know that the system will become available very soon. Otherwise you can
wait several minutes and try again.
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Illustration 123: JustSEARCH Server deactivated 
warning when storing.

Illustration 124: The Store dialog box.
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JustSEARCH manager: You can always store a file regardless if the JustSEARCH Server is
active or not. You will also be able to browse for a file and store from within the Store
dialog box.

Viewer/JustEDIT: The store option only becomes available if you have loaded a file in the
interface. Edit will ask first to save the file if necessary.

JustMONTAGE: The  montage  composition  will  be  stored  if  you  use  this  command.
Montage will first ask to save the composition if necessary.

A preview image will be generated and shown if possible. This preview will be stored in the
JustSEARCH Server for use when doing a retrieve.

You  can  enter  one  or  more  attribute  values.  The  built-in  attribute  scanner  will  try  to
determine any attribute it can find if the “autodetect” option is enabled.

JustSEARCH manager: The “clear attributes” option will clear any attribute values when
you browse for another file.

Double-click on the Value field to enter an attribute value. You will be able to enter either
text, numbers, date/time or you have to select a fixed value from a combo-box depending on
the attribute type. Either press the Enter key or click outside the field to finish entering the
value. Use the Escape key to cancel the input. The  JustSEARCH manager may have made
some fields mandatory. In this case you must enter a value.

Tags are comma-separated values you can associate with the file you are storing.

Once you are finished setting the attribute values you can press Store to start the storing
process. Note that you will be asked to enter any mandatory fields for which you may have
forgotten to give a value.
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Movie
The Movie tool allows you to make time-lap screen captures and turn them into an  AVI
movie. You can start the Movie tool in the  JustIMAGE 5.4 User Interface by selecting the
“Movie...” command from the Tools menu.

Creating Screen Captures
There are two ways of making screen captures: built-in and external. The easier way is to use
the built-in screen capture facility.

Built-in Screen Capture
Select from within the Edit menu “Make Screen Captures...”. The Screen Capture dialog box
will appear.

You can specify the “Interval” of the captures (1–300 seconds). Using the “Hot key” will
initiate the first capture. Subsequent captures will happen automatically.

Taking screen captures will stop depending on the selected stop method:

• end key: Pressing the End key will stop the screen capture process.

• captures:  The  screen  capture  process  will  stop  after  the  given  number  of  screen
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Illustration 125: The Movie Screen Capture Tool.
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captures.

• seconds: The screen capture process will stop after the given number of seconds. This
timing will only start after the first capture.

• minutes: The screen capture process will stop after the given number of minutes. This
timing will only start after the first capture.

Press the End key if you want to stop the multi capture earlier.

Press Capture to start the capture process. Press Cancel to close the Screen Capture dialog
box without making a capture.

Using an External Screen Capture
You may already have a tool with which you can make screen captures. Make sure that you
set as output format either PNG or JPEG. 

You can use the stand-alone screen capture tool justcapt that is part of JustIMAGE 5.4.

Select  the “Multi  Capture” option.  You can specify  the “Interval”  of  the captures (1–300
seconds). Using the “Hot key” will initiate the first capture. Subsequent captures will happen
automatically.

Taking screen captures will stop depending on the selected stop method:

• end key: Pressing the End key will stop the screen capture process.

• captures:  The  screen  capture  process  will  stop  after  the  given  number  of  screen
captures.

• seconds: The screen capture process will stop after the given number of seconds. This
timing will only start after the first capture.

• minutes: The screen capture process will stop after the given number of minutes. This
timing will only start after the first capture.

Press the End key if you want to stop the multi capture earlier.

Select as format of the generated files “PNG”.

A screen capture will result in a file that is generated in the “Output Directory”. The default
is to use your “My Pictures” directory. Use the browse button to change the directory.

You can set a fixed output file name, use some time stamp pattern or a sequence number
pattern. The default is:  justcapt_%Y%m%d_%H%M%S. This will generate a file name with a
time stamp, such as justcapt_20071115_123620. Pattern syntax: %d = day, %m = month,
%Y = year,  %H = hour, %M = minutes,  %S = seconds, %% = %, # = sequence number digit. Use
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multiple # to specify a sequence number. For example, ### will result in the sequence 001,
002, etc. The file name extension is automatically added depending on the selected output
format.

Press Capture to start the capture. Press Close to abort.

After the captures have been made, select within Movie  Edit Add Folder to select a
folder containing screen captures.  Alternatively you can add one or more files with  Add
Files. The files will appear in the list.

Creating a Movie

Selected files can be moved up or moved down the list one step at the time. To delete files
either select  Edit Delete or press the  Delete key.  It is possible to remove successive
input files that are identical with the option  Edit  Remove same files.

You must specify an “Output File”. Currently only AVI containers are allowed and the video
codec is  MS MPEG4 V2. (msmpeg4v2) The “Title” and “Author” fields are optional. Some
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video tools will show this information.

Frames per second (“Frames/second”) controls the speed the movie plays. The default is 1.0
which means that each screen shot is shown for 1 second. More frames/second increases the
speed, while lower values slows down the speed.

Select File Create Movie to create the movie.
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FlexNet Borrow
The FlexNet borrow tool allows you to borrow a JustIMAGE FlexNet license. The advantage
of a license borrow is that you can use the JustIMAGE program without having access to the
license server. 

Start the FlexNet borrow tool in the JustIMAGE 5.4 User Interface by selecting the “FlexNet
borrow...” command from the Help menu.

Important: The FlexNet borrow tool is only available in the FlexNet version of  JustIMAGE
5.4. Support for borrow must be enabled in the FlexNet license as well.

Borrow a License

To borrow a JustIMAGE FlexNet license select “Borrow a JustIMAGE License” and press
“Next”. 
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Illustration 127: FlexNet license borrow wizard
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Optionally, you can specify the end time as well but by default the license will be valid until
the end of the selected day.

Select the end date of the borrow period and press “Next” to continue.
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Illustration 128: FlexNet borrow end date selection
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After selecting the date you have to press “Finish” to borrow a license. When the license is
successfully borrowed the following pop-up appears.

When the borrow of a license fails an error will pop up. 

Return a borrowed license
If you no longer need the borrowed JustIMAGE 5.4 license, and the license period is not over,
you can return the license.  You need to have a working network connection with the license
server in order to return the license.  
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Illustration 129: FlexNet borrow summary.

Illustration 130: FlexNet borrow successful.
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Start the FlexNet borrow tool and select “Return a borrowed JustIMAGE license” and press
“Next”.

 

The wizard will show the information about the current borrow period and when you press
“Finish” the license will be returned.
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Illustration 131: FlexNet license borrow: return a 
license.
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When the license could successfully be returned the following pop-up appears.
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Illustration 132: Return a borrowed license

Illustration 133: Successful return of a borrowed license.
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